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Thank you for purchasing this Panasonic product.
■ Before using this software, please read the instructions carefully.
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Precautions and Disclaimers
zz Precautions regarding security
When using the Geometric & Setup Management Software (Geometry Manager Pro), security breaches of the type described
below are conceivable.
zz Leakage of your private information via this software
zz Illegal operation of this software by a malicious third-party
zz Harm to or cessation of operation of this software by a malicious third-party
Be sure to implement sufficient security measures.
zz Make sure the password is as hard to guess as possible.
zz Change the password periodically.
zz Panasonic Corporation and its affiliated companies never directly ask customers for their password. Do not give out your
password even if directly asked by a third-party representing themselves as Panasonic Corporation.
zz Always use on a network that has safety protection such as a firewall implemented.
zz Set the password for the computer you are using in order to set limits on user accessibility.
zz This software makes use of the following software.
A portion of this software is based in part on the work of the Independent JPEG Group.
zz The illustrations and display examples used in this manual may differ from the actual product.
zz Panasonic cannot be held liable for damages arising from data corruption or loss as a result of using this projector.
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What You Can Do with Geometry Manager Pro
Using this software allows you to perform real-time geometric compensation and other fine adjustments and corrections that
cannot be handled on the projector side.
Even when you use this software, however, some functions and expanded functions may be limited if projector and computer
activation are not completed.
“Activation” (page 12)
“Functions which are expanded as a result of activation” (page 20)

 Geometry correction
When projecting images onto a screen surface that is not perfectly flat (such as the
wall of a building) or projecting them onto a screen surface at an angle, the images
become distorted.
When projecting images in these kinds of special environments, the geometry
correction function serves to correct the images to counter the shape of the screen
surface.

 Edge blending
This function serves to correct the brightness and makes the joins between the
images less visible when the images projected from a multiple number of projectors
are combined to form a single image.

 Uniformity
This function makes it possible to correct color irregularities in projected images
– for example, those resulting from irregularities in the screen surface or from
surrounding light and shade.

 Masking
This function makes it possible to mask certain parts of the projected images,
projecting only the required parts.

 Auto Screen Adjustment (AUTO ADJUST)
This allows simple automatic adjustment of geometry correction, edge blending, color, and brightness according to the
shape of the screen through use of a camera.

Note
zz Both Geometry Manager Pro and the Geometry Manager Pro - Auto Screen Adjustment plug-in software must be
installed to use the Auto Screen Adjustment function.
“Camera connection” (page 87)
zz To use the Auto Screen Adjustment function, prepare a camera separately.

 Other functions
The lens, color matching and input signal can all be adjusted.
Some of the projector’s menu operations can also be carried out on a computer screen.
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Check Your Computer
System requirements
The computer must meet the following requirements in order to use the supplied software.
OS: Microsoft Windows 7		
Ultimate 32/64bit, Professional 32/64bit
			
Home Premium 32/64bit
Windows 8.1		
Windows 8.1 32/64bit, Windows 8.1 Pro 32/64bit
Windows 10		
Windows 10 32/64bit, Windows 10 Pro 32/64bit
Compatible with English, Japanese or Chinese language versions of the above operating systems.
• Compatible with Windows 7 up to SP1.
		
• For a 64bit OS, this application runs on WOW64.
CPU:
Clock speed of 1 GHz or higher
Memory:
2 GB or more
Available disk space:
16 GB or greater (Further available space is necessary to save projector information)
Other requirements:
		
A display with a resolution of 1 024 × 768 pixel or higher using High Color (16 bit) or higher
		
LAN port for a wired LAN (10Base-T/100Base-TX / 1000Base-T) or a serial port (RS-232C compliant)
		
USB2.0-compatible port or higher (when using the Auto Screen Adjustment function)

Note
zz A LAN connector is required to use the Auto Screen Adjustment function.
zz Please understand that operation is not guaranteed if this software application is used in a system environment other than
that specified above or on a home-built computer.
Proper operation cannot be guaranteed for all computers even if they satisfy the above requirements.

Necessary Environment for Computers to be Connected
Be sure to check the following settings when connecting projectors to the computer via a wired LAN connection.
Computer with a built-in LAN function
zz Is your LAN switched on?
Computer without a built-in LAN function
zz Is your LAN adapter properly recognized?
Please install the LAN adapter driver beforehand.
For details on how to install the driver, please refer to instructions accompanying the LAN adapter.
zz Is your LAN adapter switched on?

Note
zz It may not be possible to establish a connection with the projector if security (firewall) software or utility software for LAN
adapter are installed.
“Frequently Asked Questions” (page 109)
Operation
is not guaranteed for all LAN adapters and built-in LAN adapters in the computers.
zz
zz An Internet connection is required to perform activation.
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Installing/Uninstalling Software
Installation
Quit any applications running in Windows before starting installation. Failure to do so may result in improper installation.

Installing Geometric & Setup Management Software (Geometry Manager Pro)

1

Download the software.
zz Download Geometry Manager Pro.
Log in to PASS*1 on the Panasonic website (http://panasonic.net/avc/projector/pass/), click [Software Download], and
follow the on-screen instructions to download the software. You must be registered with PASS to log in to it.
*1 PASS: Panasonic Professional Display and Projector Technical Support Website. For details on PASS, refer to the
Panasonic website (http://panasonic.net/avc/projector/pass/).

Note
To enable use of the Auto Screen Adjustment function, download the Auto Screen Adjustment plug-in software as well.
“Installing the Auto Screen Adjustment plug-in software” (page 8)

2

The installer starts up.
Double-click the downloaded “Installer.exe” file.

Follow the on-screen instructions to install the application.

3

As soon as the installation process is completed, a shortcut icon is created on the desktop.

Note
If an identical version of the software is already installed, the following screen for selecting whether to repair or remove the
existing version appears.
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Installing/Uninstalling Software

Installation

 To repair defects in the software, select “Repair Geometry Manager Pro”, and click [Finish].
To uninstall the existing version before installing the software again, select [Remove Geometry Manager Pro], and
click [Finish].
 If you selected [Repair Geometry Manager Pro] and the “Insert disk” message is displayed, uninstall the
application, and then reinstall it.

Installing the Auto Screen Adjustment plug-in software

1

Download the Auto Screen Adjustment plug-in software.

2

The installer starts up.

zz Both Geometry Manager Pro and the Geometry Manager Pro - Auto Screen Adjustment plug-in software are
necessary to use the Auto Screen Adjustment function.
Log in to PASS on the Panasonic website (http://panasonic.net/avc/projector/pass/), click [Software Download], and
follow the on-screen instructions to download the Auto Screen Adjustment plug-in software.

Double-click the downloaded “AusInstaller.exe” file, and follow the on-screen instructions to install the application.

Note
The compatible combination of versions for the Auto Screen Adjustment plug-in software and the Geometry Manager Pro
software is predetermined. Therefore, an error message will appear if you attempt to install an incompatible version of
the Auto Screen Adjustment plug-in software. In such cases, check whether the version of Geometry Manager Pro that
appears in the error message matches the software version found on the above website. If the versions match, download
and install only Geometry Manager Pro from the website. If the versions do not match, download and install both Geometry
Manager Pro and the Auto Screen Adjustment plug-in software.

3

When installation is complete, the [AUTO ADJUST] (Auto Screen Adjustment) button at the top right of the
Geometry Manager Pro main screen will be enabled.

Note
If you click the [AUTO ADJUST] button while the Auto Screen Adjustment plug-in software is not installed, a message
indicating that installation of the plug-in software is required will appear.
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Installing/Uninstalling Software

Software Uninstall

Software Uninstall
Windows 7
Select [Geometry Manager Pro] from [Start] → [Control Panel] → [Uninstall a program], and click [Uninstall].
Windows 8.1 / Windows 10
Press [X] while holding down the [Windows logo] key on the keyboard. Select [Geometry Manager Pro] from [Control Panel] →
[Uninstall a program], and click [Uninstall].

Note
Uninstalling Geometry Manager Pro will not uninstall the Auto Screen Adjustment plug-in software. Perform the same
procedure as the above to uninstall the Auto Screen Adjustment plug-in software (Geometry Manager Pro - Auto Screen
Adjustment plug-in).
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Preparation
There are two ways to connect the computer to the projector. One uses a LAN connection and the other uses a serial
connection.
Projectors connected via a LAN connection and projectors connected via a serial connection cannot be corrected or adjusted
at the same time.

 Projectors supported
For details on models compatible with Geometry Manager Pro, check the information found on the software download page
after logging in to PASS on the Panasonic website (http://panasonic.net/avc/projector/pass).

Note
No guarantees are made for the operations when the computer is connected to a non-supported projector.

 Projector and computer connections
LAN connection
Connect the projector and computer using a LAN cable.
Up to 99 projectors can be connected.

Note
zz Please use a crossing cable to connect the computer and projector when it is directly connected to the LAN.
zz When using a hub to connect, whether or not a straight cable or crossing cable or both can be used depends on the
system configuration. Please consult your network administrator for details.
Serial (RS-232C) connection
Connect the projector to the computer on a 1:1 basis using a serial cable.
Use a cable complying with the RS-232C standard as the serial cable.

Note
zz For the types of cables that can be used, refer to the operating instructions of the projector.
zz Use a LAN connection when using the Auto Screen Adjustment function.
Auto Screen Adjustment cannot be performed via a serial (RS-232C) connection.
“Auto Screen Adjustment” (page 87)

 Setting the Computer
Network Setup
zz Set the IP ADDRESS, SUBNET MASK and DEFAULT GATEWAY according to the operating environment.
(Please consult your network administrator for details.)
zz If “use of automatic script” is checked for your web browser, please uncheck.
zz If “Use of Proxy server in LAN” is checked for your web browser, please uncheck, or set the projector IP address to
“Exceptions” in the detailed proxy settings.
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Preparation

 Setting the Projector
Network Setup
Set the IP address, subnet mask, and default gateway according to your operating environment. (Please consult your
network administrator for details.)
Set DHCP to OFF and set a fixed IP address, making sure that the entered IP address is not used by any other device on
the LAN.
If the entered IP address is used by another device, the projector cannot be registered.
zz For models that can be set, enable both WEB Control and Command Control.
zz For models in which the Web port number can be set, set the port number to “80”.

Note
zz Refer to operating manual of the projector for method on configuring the projector.
zz This software identifies the projector using the configured IP address. If DHCP is set to ON in the projector network setting
in a network environment that uses a DHCP server etc. the DHCP server may change the IP address allocated to the
projector, making it impossible to connect using this software.
Please ensure the server does not change the IP address by, for example, setting the DHCP server so as to fix the IP
address allocated to the projector. (Please consult your network administrator for details.)

 Activation
There are functions that are enabled and functions that are expanded by performing activation.
The upgrade kit (ET-UK20), Auto Screen Adjustment upgrade kit (ET-CUK10), and Auto Screen Adjustment upgrade kit (PC)
(ET-CUK10P) are required for activation. For details on compatible projector models, check the information found on the
activation page by logging in to PASS on the Panasonic website (http://panasonic.net/avc/projector/pass/).
“Functions which are expanded as a result of activation” (page 20)

Note
The Auto Screen Adjustment plug-in software must be installed and the Auto Screen Adjustment upgrade kit (ET-CUK10) must
be applied on the projector or the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P) must be applied on the computer to
enable the Auto Screen Adjustment function.

 Camera connection
To use the Auto Screen Adjustment function, prepare a camera separately.
For details on supported cameras and lenses and how to connect the camera to the computer, refer to “Auto Screen
Adjustment” (page 87).
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Activation
There are functions that are enabled and functions that are expanded by performing activation.
There are two methods of activation: one is to apply a kit on the projector to add or expand the functions of the projector
(projector activation) and the other is to apply a kit on the computer to expand the functions of the software installed on that
computer (computer activation).
The upgrade kit (ET-UK20) and Auto Screen Adjustment upgrade kit (ET-CUK10) are required for the former method and the
Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P) is required for the latter method. For details on compatible projector
models, check the information found on the activation page by logging in to PASS on the Panasonic website (http://panasonic.
net/avc/projector/pass/).
“Functions which are expanded as a result of activation” (page 20)

Note
Both Geometry Manager Pro and the Auto Screen Adjustment plug-in software must be installed to use the Auto Screen
Adjustment function.

Perform the projector activation
The flow of operations from installation to activation is as follows.
This sections describes projector activation.

Key code

Device
information file

Activation code

Activation code
ACTIVE.LST

Software installation

SERIAL.LST

1

Device information file

Have the key code ready.
The key code is indicated on the key code label of the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit
(ET-CUK10).
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Activation

Perform the projector activation

2

Start the software application, and display the main screen.

3

On the [File] menu, select [Activation] - [Export Equipment Profile] - [ET-UK20/ET-CUK10].

“Adjustment and Settings – Main screen” (page 25)

zz All the projectors to which the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit (ET-CUK10) is not
applied will be targets for operation.
zz All connected projectors will be displayed in the common operation area. However, the operation cannot be performed
while two or more of these projectors are selected.
zz In the common operation area, an asterisk (*) appears to the left of projector names for which the upgrade kit (ET‑UK20)
has not been applied. You can check whether the Auto Screen Adjustment upgrade kit (ET-CUK10) is applied when using
the Auto Screen Adjustment function.

The file save screen is displayed.

4

Specify the save destination, name the file, and save.
zz The default file name is “SERIAL.LST.”
When the confirmation screen for saving the file appears, click [OK].

5
6

Start the web browser, and log in to PASS of the Panasonic website (http://panasonic.net/avc/projector/pass/).
Click the activation button in the side menu of the top page, and follow the on-screen instructions to perform key
code registration, etc.
Register the key code readied in step 1 and the file (default file name: SERIAL.LST) saved in step 4 to PASS to acquire the
activation code file (default file name: ACTIVE.LST).
zz The activation codes for the upgrade kit (ET-UK20) and the Auto Screen Adjustment upgrade kit (ET-CUK10) must be
acquired separately.

7

Close the web browser.
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Activation

Perform the projector activation

8

On the [File] menu, select [Activation] - [Activate License] - [ET-UK20] or [ET-CUK10].

9

Select the activation code file (default file name: ACTIVE.LST) acquired in step 6.

The file selection screen is displayed.

When activation is complete and the confirmation screen appears, click [OK].

14

Activation

Perform the computer activation

Perform the computer activation
This section describes computer activation.

1

Have the key code ready.
The key code is indicated on the key code label of the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P).
Computer
installed the
software

Key code

2
3

4

Start the software application, and display the Connection Setting screen or the main screen.
Select [Activation(ET-CUK10P)] - [Export Volume Serial] from the [Option] menu of the Connection Setting screen
or [Activation] - [Export Equipment Profile] - [ET-CUK10P] from the [File] menu of the main screen.

The [Input Key Code] screen appears.
In the [Input Key Code] screen, enter the key code indicated on the key code label.
The key code consists of 25 single-byte alphanumeric characters. All letters should be uppercase, and 5 characters
should be entered in each box.

Click [OK] to display the file save screen.
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Activation

5

Perform the computer activation

Save the Volume Serial file ("SERIAL.LST") to any location.
Volume serial file

Key code

SERIAL.LST
or
Volume serial number

You can change the file name as desired, but do not change the extension (.LST). To return to the [Input Key Code]
screen, click [Cancel] in the file save screen. When saving of the file is completed, the [Input Key Code] screen closes.
Once the file has been saved, the volume serial number (20 single-byte alphanumeric characters) appears in the [Input
Key Code] screen.
If you will enter this volume serial number manually to download an activation code file later in this procedure, write down
this code and take care not to lose it before activation is completed.

6
7

Start the web browser, log in to PASS on the Panasonic website (http://panasonic.biz/projector/pass/), and click
the [Activation] button from the side menu of the member top page.
Follow the on-screen instructions to download the activation code file.
Download the activation code file ("ACTIVE.LST") using one of the following two methods.

Volume serial file

Activation code file

SERIAL.LST

ACTIVE.LST

or
Volume serial number

or
Activation code

Key code
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Activation

Perform the computer activation

When using a volume serial file (default file name: SERIAL.LST)
Follow the on-screen instructions to upload the volume serial file to PASS, enter the key code, and download the activation
code file ("ACTIVE.LST") to any location.
zz You can change the activation code file name as desired, but do not change the extension (.LST).
zz The activation code (30 single-byte alphanumeric characters) is displayed after the activation code file is downloaded,
but it is not used when using the activation code file ("ACTIVE.LST") to perform activation later in this procedure. If you
will enter the activation code manually to perform activation, write down this code and take care not to lose it before
activation is completed.
When entering the volume serial number manually
Follow the on-screen instructions to register the volume serial number to PASS, enter the key code, and download the
activation code file ("ACTIVE.LST") to any location.
zz The volume serial number consists of 20 single-byte alphanumeric characters. All letters should be uppercase, and 5
characters should be entered in each box.
zz You can change the activation code file name as desired, but do not change the extension (.LST).
zz The activation code (30 single-byte alphanumeric characters) is displayed after the activation code file is downloaded,
but it is not used when using the activation code file to perform activation later in this procedure. If you will enter the
activation code manually to perform activation, write down this code and take care not to lose it before activation is
completed.

8

Close the web browser.

9

Perform activation.
Perform activation using one of the following two methods.
Activation code file

ACTIVE.LST
or
Activation code

When using the activation code file (default file name: ACTIVE.LST)
1) Select [Activation(ET-CUK10P)] - [Activate Software License] from the [Option] menu of the Connection Setting screen
or [Activation] - [Activate License] - [ET-CUK10P] from the [File] menu of the main screen and then click the [By import
"Activation Code" file] button.
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Activation

2)

Perform the computer activation

Select the activation code file (default file name: ACTIVE.LST) downloaded from PASS.

When entering the activation code manually
1)	Select [Activation(ET-CUK10P)] - [Activate Software License] from the [Option] menu of the Connection Setting screen
or [Activation] - [Activate License] - [ET-CUK10P] from the [File] menu of the main screen and then click the [By
entering "Activation Code"] button.
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Activation
2)

10

Perform the computer activation

After downloading the activation code file, enter the last 13 characters of the displayed activation code.
zz The activation code consists of 30 single-byte alphanumeric characters. All letters should be uppercase, and 3
characters should be entered in the first box and 5 characters should be entered in each of the remaining boxes for
the last 13 characters.

When activation is completed, the activation code is registered to the computer.

When the confirmation screen appears, click [OK].

Note
zz If activation failed, check the following again.
- The key code input in the [Input Key Code] screen in step 4 and the key code input when uploading the volume serial
file (default file name: SERIAL.LST) to PASS or registering the volume serial number to PASS are different.
- The volume serial file or the volume serial number created in step 5 and the volume serial file uploaded to PASS when
generating the activation code or the volume serial number entered when registering to PASS are different.
zz When computer activation is completed, the [AUTO ADJUST] button at the top right of the main screen changes as
shown below.

Before activation

After activation

19

Activation

Functions which are expanded as a result of activation

Functions which are expanded as a result of activation
Listed below are the functions which are expanded when the activation process has been completed.

 Upgrade kit (ET-UK20)
Function

Grid pattern

Geometry
Correction

Uniformity

Activation not completed

Activation completed

When the resolution of the projector
is 1920 x 1200 dots or 3840 x 2400
dots

2×2 to 11×11

2×2 to 41×26

When the resolution of the projector
is 1400x1050 dots

2×2 to 11×11

2×2 to 29×22

Vertical keystone
correction

±40°

±45°

Horizontal keystone
correction

±15°

±40°

Vertical arcs

±50

±100

Horizontal arcs

±50

±100

Rotational correction

–

√

Flip Vertical
Flip Horizontal

–

√

Flexible Correction

–

√

Flip Vertical
Flip Horizontal

–

√

–

√

Adjustment
ranges

Masking
		
		

√ : Can be used.
– : Cannot be used.

 Auto Screen Adjustment upgrade kit (ET-CUK10) / Auto Screen Adjustment upgrade kit
(PC) (ET-CUK10P)
This allows simple automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape
of the screen through use of a camera.

Note
zz Both Geometry Manager Pro and the Auto Screen Adjustment plug-in software must be installed to use the Auto Screen
Adjustment function.
“Camera connection” (page 87)
zz To use the Auto Screen Adjustment function, prepare a camera separately.
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Starting and Exiting the Application
Starting the application
Double-click the shortcut icon on the desktop.
When the application starts, the connection settings screen appears.

LAN connection

Serial (RS-232C) connection

File connection

To use a LAN connection for the projector and computer, select [
]; alternatively, to use a serial (RS-232C)
].
]. Also, to connect by loading a saved file, select [
connection, select [
The following items can be selected from the [Option] menu at the top left of the connection settings screen.
Activation (ET-CUK10P)
This performs Auto Screen Adjustment upgrade kit (PC) activation.
Export Volume Serial
This creates a volume serial file (file registered to PASS).
This file is required to acquire the activation code file.
“Activation” (page 12)
Activation Software License
This performs computer activation. An activation code file or activation code is required.
“Activation” (page 12)
Service Password
This menu is used to support maintenance by Panasonic. It is not normally used.
Version
This is where the application’s version information can be checked.
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Starting and Exiting the Application

Starting the application

 LAN connection
Select [

] and configure the following settings.

IP Address
Input the IP address of the projector to be connected to the computer. When searching for a connected projector, enter
an IP address to start searching.
End IP Address
When searching for a connected projector, select the check box and enter an IP address to end searching.

NOTE
zz Specify the same network address for the IP Address and End IP Address.
zz If the search range is too wide, an error will occur when you start the search.
Port
Set the number of port on the computer for connecting with the projector.
User Name
Input the user name used for WEB control of the connected projector.
Password
Input the password used for WEB control of the connected projector.
When not searching for a connected projector, click [Connect] after configuring the settings to display the main screen.
“Adjustment and Settings – Main screen” (page 25)
When searching for a connected projector, click [Search] after configuring the settings to start the search according to the
settings. The projector search screen is displayed while the search is in progress.

Cancel
Cancel the search.
When a search is canceled, projectors that have
been detected up to that point will be displayed.
Connected projector list
Displays a list of projectors that were detected via
the search.

Connect
Connect to the selected projectors, and display
the main screen.
"Adjustment and Settings –
Main screen" (page 25)
Clear All
Clear selection of all detected projectors.
Select All
Select all detected projectors.

When [Exit] is clicked, the application is exited without establishing a connection.
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Starting and Exiting the Application

Starting the application

 Serial (RS-232C) connection
Select [

] and configure the following settings.

Projector ID
Select [All] or [1] to [64].
If [All] has been selected, all the projectors with [All] set for [Projector ID] and [On] set for [Response (ID All)] can be
used.
When a number from [1] to [64] has been selected, the projectors set to the same ID ([1] to [64]) can be used.
For the [Projector ID] and [Response (ID All)] settings, refer to the Operation Manual of the projector.
Port
The ports which can be used on the computer are displayed here.
Baud Rate
Set the baud rate from the speeds given below:
zz 9600 bps
zz 19200 bps
zz 38400 bps
Parity
Set the parity used for the parity check here:
zz NONE: No parity
zz ODD: Odd parity
zz EVEN: Even parity

 File connection
Select [

] and configure the following settings.

File path
Specify a file (with .prjc or .prjs extension) saved in the past.
Click [Select] to open the file selection screen.
“Adjustment and Settings – Main screen” (page 25)
After performing the settings, click [Connect] to display the main screen.
When [Exit] is clicked, the application is exited without establishing a connection.

Note
The following screen appears when you connect to a projector for which the upgrade kit (ET-UK20) has not been applied.
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Starting and Exiting the Application

Exiting the application

Exiting the application
To exit the connection main screen, either select [File] and then [Exit] or click the
button at the top right of the window.
To exit the connection settings screen, either click the [Exit] button or click the
button at the top right of the window.
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Adjustment and Settings
Main screen
The main screen consists of the following five general areas and the AUTO ADJUST (Auto Screen Adjustment) button.
Adjustment area

Main menu

AUTO ADJUST (Auto Screen
Adjustment) button

Icon menu

Common operation area

Status bar

Note
zz When using this application, keep the main power of the projector in the “on” setting.
If the standby mode is set to [Normal], the [Power ON] operation is enabled even when the projector is in standby mode.
However, if the standby mode is set to [ECO], all operations including [Power ON] will be disabled. When using this
application and performing the [Power ON] operation, set the projector’s standby mode to [Normal]. Operations other than
[Power ON] are not guaranteed, when the standby mode is set to [Normal].
zz If the projector settings have been changed using a remote control, for instance, rather than the software application, the
software application displays and projector settings may not match.

Adjustment area
You can click the tabs in the adjustment area to switch between screens and perform various adjustments and operations.
The modes in which these adjustments and operations are performed are called “editing modes.”
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Main screen

Main menu
 File submenu
Open File (Current Tab)
This loads only the setting data of the current editing mode from a setting file (with .prj extension) saved on the
computer.
zz When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
Open File (One Projector)
This loads all the editing mode settings from the setting file (with .prj extension) saved on the computer into the selected
projector.
When this menu item is selected, the loaded settings are reflected in the target projector even if
(at the
bottom of the common operation area) has not been checked.
zz When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Note
When the setting file is loaded, the settings may not be reflected correctly if the selected input signal is not the same as
the one when the setting file was saved.
Open File (All Projectors)
This loads a file saved with [Save File (All Projectors) As...].
When this item is selected, the loaded settings are reflected in all the target projectors that are connected even if
(at the bottom of the common operation area) is not checked.
zz When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Note
zz When the file is loaded, an error message is displayed if the target projector is not connected to the network. When
the connection of the target projector to the network is recognized, the connection is established and the loaded
settings are reflected automatically.
zz This function cannot be used for a serial (RS-232C) connection.
Open File (Connection Only)
This loads a setting file (with .prjc or .prjs extension) saved to the computer and reflects the status of the connection
with the saved projector.

Note
zz When the file is loaded, an error message will be displayed if the target projector is not connected to the network, but
a connection will be established automatically when the computer recognizes that the target projector is connected
to the network.
zz Even if a setting file (with .prjs extension) is selected, the settings of the projector target for connection are not
reflected.
zz This function cannot be used for a serial (RS-232C) connection.
Save File (One Projector)
This saves the settings being edited, overwriting the previous settings in the current setting file (with .prj extension).
When the file is saved for the first time, a message appears prompting the user to provide a filename.
Save File (One Projector) As...
This saves the settings now being edited in a file under the filename (with .prj extension) provided.
Save File (All Projectors) As...
This saves the setting information of all the currently connected projectors as a single All Project File (with .prjs
extension) on the computer.
The layout information, IP addresses, user names, and passwords of the projectors are also encrypted and saved in the
All Project File.

Note
This function cannot be used for a serial (RS-232C) connection.
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Main screen

Save File (Connection Only) As...
This saves the connection information of all the currently connected projectors as a single file (with .prjc extension) on
the computer.
The IP addresses, user names, and passwords of the projectors are also encrypted and saved.

Note
This function cannot be used for a serial (RS-232C) connection.
Reset Data (Current Tab)
This sets the current editing mode settings to the initial statuses.
zz When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
Reload (Current Tab)
This cancels the settings currently being edited using the application, and loads the same settings again from the
projector.
zz When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
Activation
Export Equipment Profile (ET-UK20 / ET-CUK10 / ET-CUK10P)
Creates a file to be registered in PASS. This file is required to acquire the activation code file.
“Activation” (page 12)
Activate License (ET-UK20 / ET-CUK10 / ET-CUK10P)
Select [ET-UK20], [ET-CUK10], or [ET-CUK10P] and then perform activation.
“Functions which are expanded as a result of activation” (page 20)
zz The activation code file is required.
“Activation” (page 12)
zz If the Auto Screen Adjustment plug-in software is not installed, [ET-CUK10] or [ET-CUK10P] cannot be selected.
“Installing the Auto Screen Adjustment plug-in software” (page 8)
Export
Multi Monitoring and Control Software
This saves the data in the file format (with .ugk extension) used for the “Multi Monitoring & Control Software”.
The file is for registering the data of the projectors already registered in the software application in the “Multi Monitoring
& Control Software” for monitoring and control purposes.
For details, refer to the operation manual of the “Multi Monitoring & Control Software”.

Note
This function cannot be used for a serial (RS-232C) connection.
Exit
Exits the software.
zz When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
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Main screen

 Edit submenu
Undo
This discards the software application and projector settings currently being edited.
It returns these settings to the status before the setting data is sent.
Redo
This returns the settings to the ones before the Undo operation is performed.

Note
zz Undo and Redo can be used up to 50 times during a single setting process (for each editing mode).
zz The Undo and Redo logs are cleared if you switch to another editing mode or projector.
The following Edit submenu items are enabled only in certain editing modes. For details, refer to the respective reference
pages.
Lock
“Adjustment and Settings − Geometry Correction” (page 41)
Unlock
“Adjustment and Settings − Geometry Correction” (page 41)
Free
“Adjustment and Settings − Geometry Correction” (page 41)
Reset

“Adjustment
and Settings − Geometry Correction” (page 41), “Adjustment and Settings − Uniformity” (page 61),
“Adjustment and Settings − Masking” (page 70)
Flip Vertical
“Adjustment and Settings − Geometry Correction” (page 41), “Adjustment and Settings − Uniformity” (page 61),
“Adjustment and Settings − Masking” (page 70)
Flip Horizontal
“Adjustment and Settings − Geometry Correction” (page 41), “Adjustment and Settings − Uniformity” (page 61),
“Adjustment and Settings − Masking” (page 70)
Area Select
“Adjustment and Settings − Uniformity” (page 61)
Point Select
“Adjustment and Settings − Uniformity” (page 61)
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Main screen

 View submenu
Tool Bar, Status Bar, Sub Window, Layout Window
Enter a check mark, and select whether the items are to be displayed.
In the initial status, “Tool Bar” and “Status Bar” are displayed.
Auto Transfer
When a check mark is entered for this and then settings are changed, the changed settings are reflected in the
projector as soon as they are changed.
zz Entering a check mark causes a check mark to appear in
area.

in the lower left of the common operation

Line Color
White / Red / Green / Blue
These perform the same operations as the icon menu [White], [Red], [Green] and [Blue] on the Geometry screen.
“Adjustment and Settings - Geometry Correction - Geometry screen” (page 41)
Coordinate Information
None / Absolute / Relative
These select the mode in which the coordinates of the control points are displayed.
“Adjustment and Settings - Main screen - Coordinate Information” (page 36)
Grid Resolution
Use Square Grid / X / Y
These select the mode in which the coordinates of the control points are displayed.
“Adjustment and Settings - Geometry Correction - Geometry screen” (page 41)
Zoom
x1/8 / x1/4 / x1/2 / x1 / x2 / x3 / x4 / x5 / x6 / x7 / x8
The editing area is zoomed in or out.
Masking Marker
Red / Green / Blue / Orange
These select whether to display the control points.
“Adjustment and Settings - Masking - Masking screen” (page 70)

 Tools submenu
Auto Screen Adjustment
This displays the Auto Screen Adjustment screen.
This performs the same operation as the [AUTO ADJUST[ (Auto Screen Adjustment) button.
“AUTO ADJUST (Auto Screen Adjustment) button” (page 37)

Note
This cannot be selected if the Auto Screen Adjustment plug-in software is not installed.

 Version submenu
About Geometry...
This displays version information for Geometry Manager Pro.
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Main screen

Icon menu
This icon menu is used in all the editing modes.
For details on the icon menu items used in each editing mode, refer to the description of the mode concerned.
Open File (One Projector)
This performs the same operation as [Open File (One Projector)] on the File submenu.
Save File (One Projector)
This performs the same operation as [Save File (One Projector)] on the File submenu.
Reload (Current Tab)
This performs the same operation as [Reload (Current Tab)] on the File submenu.
Undo
This performs the same operation as [Undo] on the Edit submenu.
Redo
This performs the same operation as [Redo] on the Edit submenu.
Layout Window
Each time this is clicked, the Layout Window screen is switched between displayed and cleared.
On the Layout Window, the positions of the projectors can be changed by means of mouse operations.
When a projector position is moved, the overall layout is automatically corrected based on the projector which was moved.
Main screen operations can be performed even while the Layout Window is displayed.
The Layout Window screen can be displayed also by selecting [Layout Window] on the View submenu.
The Layout Window screen below is an example when eight projectors are connected.

Selection area
The projector layout is displayed.
You can change the active projector by clicking one of the rectangles
representing the projectors.
The frame of the selected projector is indicated in red.

Apply
Click to apply the layout displayed in the selection area.
The screen is not closed.
Cancel
Click to close the screen without applying the layout displayed in the
selection area.
OK
Click to apply the layout displayed in the selection area and close the
screen.
Reset Data (Current Tab)
This performs the same operation as [Reset Data (Current Tab)] on the File submenu.
Open File (Current Tab)
This performs the same operation as [Open File (Current Tab)] on the File submenu.
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Main screen

Common operation area
The common operation area houses the operations which can be used in all the editing modes.
Projector list
This list displays the projector numbers, projector names and IP addresses (with
the LAN connection) or COM port numbers (with serial RS-232C connection) in the
sequence in which the projectors were connected.
The projector currently selected is the one whose data is being edited. Any projector on
the list can be selected to switch the projector whose data is to be edited.

Note
zz Multiple projectors can be selected as targets for operations by holding the Ctrl key
while clicking. In that case, the following functions can be operated.
Power ON/Standby, Shutter ON/Shutter OFF, Status ON/Status OFF, Status Page,
Test Pattern, Display Projector Name, Grid Resolution, Display Grid Lines
zz When a projector for which the upgrade kit (ET-UK20) has not been applied is
connected, an asterisk (*) appears to the left of that projector name. An error
message will appear if you connect to this projector and attempt to use the extended
functions.
“Activation” (page 12)
zz When a projector on the list is selected and then double-clicked, the WEB control
screen opens. For details on the WEB control screen, refer to the operating
instructions of the projector.
zz When the mouse pointer is placed over a projector on the list, a tooltip appears and
shows the model number and resolution of that projector..
/
These change the order of the projectors in the list.
Select a projector in the list and then click the up arrow button to move it up one place
in the list or click the down arrow button to move it down one place in the list.

Note
zz Multiple projectors cannot be moved at the same time.
zz When the up arrow button is clicked while the very top projector is selected or when
the down arrow button is clicked while the very bottom projector is selected, the
projector does not move.
zz The results of moving the projectors are reflected in Layout Window.
"Layout Window" (page 30)

Del
Click to remove the selected projector from the operating targets.
When all the projectors are removed, the software is exited.
This cannot be selected if the serial connection is used for the projectors.
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Main screen

Rename
Click to change the name of the currently selected projector.
A name can consist of a maximum of 12 characters including letters (upper-case),
numbers, hyphens and periods.
Display Projector Name
Click to display the name and number of the currently selected projector on the image
projected by the projector.
Add
Click to display the LAN connection destination selection screen and add a new
projector.
“Adjustment and Settings − Main screen − LAN connection destination selection
screen” (page 33)
zz It cannot be selected if the serial connection is used for the projectors.
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Main screen

LAN connection destination selection screen
When
is clicked, the LAN connection destination selection screen is displayed.
A projector that is going to be connected now be set.
IP Address
Input here the IP address of the projector to be connected.
To search for a connected projector, enter an IP address to start searching.
End IP Address
To search for a connected projector, select the check box and enter an IP
address to end searching.

Note
zz Specify the same network address for the IP Address and End IP
Address.
zz If the search range is too wide, an error will occur when you start the
search.
Port
Set here the number of the port that is to be connected to the projector.
User Name
Input here the user name of the projector to be connected.
Password
Input here the password of the projector to be connected.
Exit
Click to cancel the connection with the projector and close the LAN
connection destination selection screen.
Connect / Search
When not searching for a connected projector, connection to the projector
will be established according to the entered settings.
When searching for a connected projector, the projector search will start
according to the entered settings.
A status screen is displayed while the search is in progress.
"Starting
and Exiting the Application − Projetor Search Screen" (page 22)
When the projector is connected successfully, the LAN connection
destination selection screen is closed.
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Main screen
Power ON/Standby
Click the left button to set the power of the selected projector to the “On” state or click the
right button to set it to the standby state.
The setting is reflected in the projector even when a check mark has not been entered in
.

Note
When the projector is in the standby state, no guarantees are made for any operations
except [Power ON].
Shutter ON/Shutter OFF
Click the left button to set the shutter of the selected projector to the “On” state or click
the right button to set it to the “Off” state.
The setting is reflected in the projector even when a check mark has not been entered in
.
Status ON/Status OFF
Click these to select to display (ON) or not display (OFF) the status (information) on the
images of the selected projector.
The setting is reflected in the projector even when a check mark has not been entered in
.
Status Page
Click these to select the previous or next page of the status screen when the status is
displayed on the projector’s image.
The setting is reflected in the projector even when a check mark has not been entered in
.
Test Pattern
Click to switch the image projected from the projector to the test pattern.
Any of the following test patterns can be selected.
OFF, White, Black, Red, Green, Blue, Cyan, Magenta, Yellow, Window, Window
(Inversion), Colorbars (Vertical), Colorbars (Horizontal), 16:9 / 4:3, Crosshatch
(White), Crosshatch (Red), Crosshatch (Green), Crosshatch (Blue), Crosshatch
(Cyan), Crosshatch (Magenta), Crosshatch (Yellow)
Default value: OFF
The setting is reflected in the projector even when a check mark has not been entered in
.
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Main screen

When a check mark is entered for
, the two grid resolutions
(horizontal and vertical) become one, and the button for selecting the combination of the
number of grids whose horizontal and vertical intervals are identical is selected.
Any of the following numbers of square grids can be selected.
When the resolution of the projector is 1920 x 1200 dots or 3840 x 2400 dots:
41×26*, 33×21*, 25×16*, 17×11*, 9×6
When the resolution of the projector is 1400 x 1050 dots:
29×22*, 21×16*, 9×7, 5×4
* Selectable if the upgrade kit (ET-UK20) has been applied to the projector.
“Activation” (page 12)

Grid Resolution (horizontal)
The number of grids in the horizontal direction is selected here.

Grid Resolution (vertical)
The number of grids in the vertical direction is selected here.
Any of the numbers of grids listed below can be selected.
When the resolution of the projector is 1920 x 1200 dots or 3840 x 2400 dots:
Horizontal: 2 to 41*1 (2 ~ 11)*2 (default value: 11)
Vertical:
2 to 26*1 (2 ~ 11)*2 (default value: 11)
When the resolution of the projector is 1400 x 1050 dots:
Horizontal: 2 to 29*1 (2 ~ 11)*2 (default value: 11)
Vertical:
2 to 22*1 (2 ~ 11)*2 (default value: 11)
*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected
projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected
projector.
“Activation” (page 12)
Display Grid Lines
The color of the grids to be projected is selected here.
OFF, White, Black, Red, Green, Blue, Cyan, Magenta, Yellow
Default value: OFF
The setting is reflected in the projector even when a check mark has not been entered in
.
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Main screen
Cursor Information
When a check mark is entered for
, the cursor indicating the position of the
control point can be displayed on the projected image.

Note
The cursor appears only at the top left when the control point has been selected using a
line or area.
If a multiple number of control points have been selected, the cursor will be displayed
only at the control point selected last.
Cursor

Coordinate Information
The mode in which to display the control point coordinates is selected here when grids
have been set in one of the editing modes.
None:
The coordinates are not displayed.
Absolute:	The coordinates with the top left control point used as the origin point are
displayed alongside the control points.
Relative:	The coordinates with the initial position of the control point in the selected
grid used as the origin point are displayed alongside the control points.

Note
However, if the grid intervals are narrow, the coordinates may not be displayed even
when Absolute or Relative has been selected.
Manual Transfer
When this button is clicked, the edited settings are reflected in the projector.

When a check mark is entered in
setting is reflected in the projector.
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Main screen

AUTO ADJUST (Auto Screen Adjustment) button
This allows automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape of the
screen through use of an externally connected camera.
Click the [AUTO ADJUST] button to display the Auto Screen Adjustment screen.
“Auto Screen Adjustment” (page 87)

Note
If you click the [AUTO ADJUST] button while the Auto Screen Adjustment plug-in software is not installed, a message
indicating that installation of the plug-in software is required will appear.
“Installing the Auto Screen Adjustment plug-in software” (page 8)

Status bar
This is where the progress made in the data transfer, error messages and expansion ratio of the editing area are displayed.
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Lens Settings
Lens setting screen
The lens settings are selected on this screen.

②

①

③

④

⑯

⑮

⑭

⑰

⑤
⑥
⑩
⑨
⑪
⑬
⑫

⑧⑦

①

②

③

Upward
Use this to move the projected image upward.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the amount of movement increases progressively for each button in the following order;

,

,

.

Leftward
Use this to move the projected image toward the left.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the amount of movement increases progressively for each button in the following order;

,

,

.

Rightward
Use this to move the projected image toward the right.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the amount of movement increases progressively for each button in the following order;

,

,

.
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④

⑤

⑥

⑦
⑧
⑨

⑩

⑪

⑫

⑬

Lens Settings

Downward
Use this to move the projected image downward.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the amount of movement increases progressively for each button in the following order;

,

,

.

Vertical Position
Specify the vertical position of the image as a numerical value.
Move to the specified position by clicking the [Apply] button.
This function can be used only for projectors that have this function.
Horizontal Position
Specify the horizontal position of the image as a numerical value.
Move to the specified position by clicking the [Apply] button.
This function can be used only for projectors that have this function.
Home Position
Click to move the lens position to the home position.
Lens Calibration
Click to automatically set the limit to which the lens is to be moved and the home position of the lens.
Lens Focus (Far)
Click these buttons to adjust the focus to “far”.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the further toward the left the button is located, the further the focus will move.
Lens Focus (Near)
Click these buttons to adjust the focus to “near”.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the further toward the right the button is located, the closer the focus will move.
Lens Focus
Specify the focus position as a numerical value.
Move to the specified position by clicking the [Apply] button.
This function can be used only for projectors that have this function.
Lens Zoom (Tele)
Click these buttons to reduce the size of the projected image (zoom out).
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the image is reduced in progressively larger steps by clicking the buttons progressively further toward the
left.
Lens Zoom (Wide)
Click these buttons to enlarge the size of the projected image (zoom in).
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the image is enlarged in progressively larger steps by clicking the buttons progressively further toward the
right.
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⑭

Lens Settings

Lens Memory Save
Click these buttons to save the focus position, shift position and zoom position of the adjusted lens in the projector's lens
memory.
The number of lens memories available for saving lens settings varies according to model.
Even if a check mark has not been entered for
, the settings are saved in the lens memory when the
[Save] button is clicked.
This function can be used only for projectors that have this function.

⑮

Lens Memory Load
Click these buttons to select and load the lens memory whose settings are saved in the projector.
The lens will move automatically to the saved focus position, zoom position and shift position.
Even if a check mark has not been entered for
, the settings are loaded from the lens memory when the
[Load] button is clicked.
This function can be used only for projectors that have this function.

⑯

Lens Memory Rename
Click these buttons to rename the lens memory settings.
When one of the buttons is clicked, the [Rename] screen is displayed.

When a new name is input and the [OK] button is clicked, the [Rename] screen is closed, and the name of the projector’s
lens memory settings is changed.
A name can consist of a maximum of 16 characters including letters, numbers, hyphens and periods.
If the [Cancel] button is pressed instead, the [Rename] screen is closed without renaming the lens memory settings.
This function can be used only for projectors that have this function.

⑰

Lens Memory Delete
Click these buttons to delete the settings saved in the lens memory of the projector.
Even if
Transfer is not checked, the settings are deleted from the lens memory when the [Delete] button
is clicked.
This function can be used only for projectors that have this function.
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Geometry Correction
Test patterns or grids are projected onto the screen and those parts of the image that look unnatural are corrected.
By adjusting the number of grids or number of control points, the images can be made to look more natural.
Use the mouse to make coarse corrections, and use the cursor keys on the keyboard or input numerical values to make fine
corrections.
zz Drag the control point with the mouse while holding down the Shift key to move it in either the horizontal or vertical
direction.
zz Select the control point and then press the cursor key while holding down the Ctrl key to move it in increments of 0.2 pixel.
Select the control point and then press the cursor key while holding down the Alt key to move it in increments of 4 pixels.

Note
When the number of grids displayed during ongoing adjustments is reduced, the corrected grid information may be lost.
It is recommended that a small number of grids be displayed first to make coarse adjustments and then a larger number of
grids be displayed to make fine adjustments.

Geometry screen
⑧

①② ③④

⑤

⑥

⑦

①

②
③

Sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
An image of the entire projection area is displayed on Sub Window.
 The red frame around the Sub Window indicates the display range in the editing area.
 Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.
Zoom In
Zooms in to the editing area.
Zoom Out
Zooms out the editing area.
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④
⑤
⑥

⑦

⑧

Geometry Correction

White
This corrects the RGB color components together.
Red, Green, Blue
These correct only the component of the selected color.
Editing Area
The image can be corrected by selecting the grid using the mouse.
The settings established in the operation area are also reflected in this area.
The outermost red frame indicates the maximum area which can be projected.
Operation Area
This is where the buttons, slide bars, etc. used by geometry correction are displayed.
The operations that they perform differ depending on which correction pattern has been selected.
“Operation area” (page 43)
Edit, View
The following menu items can be used on the Geometry screen.

Edit submenu
Lock
Locks the control points of the grids selected.

Note
A locked control point will not move even if the correction pattern has been changed.
The lock will not be released even if the number of grids has been changed.
Unlock
Unlocks the control points that have been selected.
Free
Click to release the control point selection.
Reset
Click to return the selected control points to the initial status.
Flip Vertical
Click to flip vertically the correction status of the entire image.
Flip Horizontal
Click to flip horizontally the correction status of the entire image.

View submenu
Grid Resolution
Use Square Grid
This makes it possible to select the combination of the number of grids which can be selected when a check
mark has been entered for

in the common operation area.

X
The number of grids in the horizontal direction is selected here.
This performs the same operation as Grid Resolution (horizontal) in the common operation area.
Y
The number of grids in the vertical direction is selected here.
This performs the same operation as Grid Resolution (vertical) in the common operation area.
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Geometry Correction

 Operation area
①

①

②

③

④

⑤

⑥

Mode Switching
OFF: Disables geometry correction.
PC-1 / PC-2 / PC-3: Enables geometry correction.

Note
When geometry correction is enabled, only one piece of data (PC) can be saved for some models.

②
③

Moving Area
Set here the range of the effects exerted on the grids around the control points that have been dragged and moved.
Smoothing
Correction using curves can be performed when a check mark is entered in
Example when the check mark is entered

④

.

Example when the check mark is not entered

Alert Distortion
has been checked, an
If a setting exceeding the geometric distortion limit is sent to the projector when
error message will be displayed on the dialog screen. The error message will be displayed on the status bar if a check
mark has been entered in
.
is checked as the default setting.
When a check mark is not entered for
, even settings exceeding the geometry correction limits can be
sent to the projector. Bear in mind, however, that in such cases the projected images may lose their shape.

⑤

Store
Click this button to save the current settings inside the projector after they have been reflected in the projector.

Note
A screen for selecting the save folder inside the projector may appear for some models.

⑥

Display Switching
Click

to minimize the operation area; conversely, click
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Selecting the control points
Select the Geometry screen and switch the mode to other than OFF. The control points can now be selected.
“Free Grid (Free-form correction)” (page 45)
Drag the control points to move them. The control points cannot be moved by selecting the lines.
A multiple number of control points can be selected
by dragging and enclosing the points where the grids
intersect.

The control points can be selected using lines by
clicking the space between one point where the grids
intersect and another such point.

The control points can be selected using a multiple
number of lines by dragging and enclosing the
spaces between one point where the grids intersect
and another such point.
When a point where the grids intersect is clicked, it
can be selected as a single control point.

By clicking (or dragging) while holding down the Ctrl key, another control point can be selected while the currently selected
control point keeps selected.
To move the selection to the adjacent control point, press the Tab key or Shift + Tab keys while one control point is selected, or
press the cursor key while holding down the Shift key.
To cancel the selection of the control point, click anywhere other than the grid with the mouse or select [Free] in the Edit
submenu displayed by right-clicking.

Right-clicking
The menu with the items described below is displayed when a grid control point is selected and the right button of the mouse
is clicked.
The menu functions are the same as with the Edit submenu.
“Edit submenu” (page 42).
Lock, Unlock, Free, Reset, Flip Vertical, Flip Horizontal
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Free Grid (Free-form correction)
The Free Grid operation area is where the operations for all the correction patterns are selected.
The corrections made with Free Grid are also reflected in the editing area of the other correction patterns.

①

①

Correction Patterns
Any of the following correction patterns can be selected.
zz Free Grid (free-form correction)
zz 4 Corner (4-corner correction)
zz Keystone (keystone shape correction)
zz Cylindrical screen (cylindrical shape correction)
zz Elliptical screen (elliptical shape correction)
zz Spherical screen (spherical shape correction)
zz Rotation (rotational correction)
The Upgrade Kit (ET-UK20) must be applied on the selected projector to enable the Auto Screen Adjustment
function.
“Activation” (page 12)
zz S-shape screen (S-shaped correction)

4 Corner (4-corner correction)
The positions of the four corners of the image are set with this type of correction.

①

①

②

⑤

⑧ ③

④

⑥

⑤

⑦

Upper Left
Set the horizontal and vertical positions of the upper left.
Setting ranges V (vertical position): 0 to 600
H (horizontal position): 0 to 768 (when the resolution of the projector is 3840×2400 dots)
0 to 600 (when the projector resolution is other than the above)
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⑨
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②

③

④

⑤
⑥
⑦

Geometry Correction

Lower Left
Set the horizontal and vertical positions of the lower left.
Setting ranges V (vertical position): -600 to 0
H (horizontal position): 0 to 768 (when the resolution of the projector is 3840×2400 dots)
0 to 600 (when the projector resolution is other than the above)
Upper Right
Set the horizontal and vertical positions of the upper right.
Setting ranges V (vertical position): 0 to 600
H (horizontal position): -768 to 0 (when the resolution of the projector is 3840×2400 dots)
-600 to 0 (when the projector resolution is other than the above)
Lower Right
Set the horizontal and vertical positions of the lower right.
Setting ranges V (vertical position): -600 to 0
H (horizontal position): -768 to 0 (when the resolution of the projector is 3840×2400 dots)
-600 to 0 (when the projector resolution is other than the above)
Reset
Click these to reset the respective settings which have been changed.
Rotation [degree]*
Set the rotational angle of the image here.
Setting range: Enter a setting from –10.0 to 10.0.
Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.
When a check mark is entered for
, the image is reduced to a size in which it can be projected when it exceeds
the projection area.
The image will not be reduced if a check mark is not entered.

⑧

⑨

Linearity
Set the linearity in the horizontal and vertical directions.
This function can be used only for projectors that have this function.
Setting range: -127 to 127
Import from CORNER CORRECTION
Reflect the correction results of [CORNER CORRECTION] in the OSD menu of the projector.
This function is available only for models that have the corner correction function in the projector.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
“Activation” (page 12)
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Keystone (keystone shape correction)
Images are corrected using the keystone shape as the reference with this type of correction.

①

①

②

③

②

④

⑤

Correction pattern adjustment area
The following settings are selected here:
zz Vertical: –45.0 to 45.0*1 (–40.0 to 40.0)*2
zz Horizontal: –40.0 to 40.0*1 (–15.0 to 15.0)*2
zz Vertical balance: –60 to 60
zz Horizontal balance: –30 to 30
The numbers in parentheses serve as the setting ranges if the selected projector has not been activated.
*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
“Activation” (page 12)

②
③

Reset
Use these to reset the settings that have been changed.
Setting
The following settings are selected here:
zz Lens Throw Ratio: 0.7 to 16.5
zz V Keystone [degree]: –45.0 to 45.0*1 (–40.0 to 40.0)*2
zz H Keystone [degree]: –40.0 to 40.0*1 (–15.0 to 15.0)*2
zz V Balance: –60 to 60
zz H Balance: –30 to 30
zz Rotation [degree]*: –10.0 to 10.0
*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
“Activation” (page 12)

④

Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.
When a check mark is entered for
, the image is reduced to a size in which it can be projected when it exceeds
the projection area.
The image will not be reduced if a check mark is not entered.

⑤

Import from KEYSTONE
Reflect the correction results of [KEYSTONE] in the OSD menu of the projector.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
“Activation” (page 12)

47

Adjustment and Settings

Geometry Correction

Cylindrical screen (cylindrical shape correction)
Images are corrected using the cylindrical shape as the reference with this type of correction.

①

①

②

③

②

④

⑥

⑤

Correction pattern adjustment area
The following settings are selected here:
zz Vertical arc: –100 to 100*1 (–50 to 50)*2
zz Horizontal arc: –100 to 100*1 (–50 to 50)*2
*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
“Activation” (page 12)

②
③

Reset
Use these to reset the settings that have been changed.
Setting
The following settings are selected here:
zz Lens Throw Ratio: 0.7 to 16.5
zz V Keystone [degree]: –45.0 to 45.0*1 (–40.0 to 40.0)*2
zz H Keystone [degree]: –40.0 to 40.0*1 (–15.0 to 15.0)*2
zz V Arc: –100 to 100*1 (–50 to 50)*2
zz H Arc: –100 to 100*1 (–50 to 50)*2
zz V Balance: –60 to 60
zz H Balance: –30 to 30
zz Rotation [degree]*: –10.0 to 10.0
*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
“Activation” (page 12)

④

Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.
When a check mark is entered for
, the image is reduced to a size in which it can be projected when it exceeds
the projection area.
The image will not be reduced if a check mark is not entered.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
“Activation” (page 12)
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⑤
⑥

Geometry Correction

Import from CURVED CORRECTION
Reflect the correction results of [CURVED] in the OSD menu of the projector.
Maintain Aspect Ratio
, correction is made so that the aspect ratio of the projected
When a check mark is entered for
image is maintained.
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the
display device.
This function can be used only for projectors that have this function.

49

Adjustment and Settings
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Elliptical screen (elliptical shape correction)
Images are corrected to fit a screen whose shape is
elliptical when viewed from above.

①

①

②

③

Correction pattern adjustment area
The following settings are selected here:
zz Width/Radius Ratio: 0.01 to 1.20
zz Flattening: 0.50 to 2.00
zz Azimuth: –45.0 to 45.0
zz Vertical balance: –60 to 60

②

Reset
Use these to reset the settings that have been changed.
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②

④

⑤
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③

Geometry Correction

Setting
The following settings are selected here:
zz Lens Throw Ratio: 0.7 to 16.5
zz V Keystone [degree] (Vertical keystone correction): –45.0 to 45.0*1 (–40.0 to 40.0)*2
zz H Keystone [degree] (Horizontal keystone correction): –40.0 to 40.0*1 (–15.0 to 15.0)*2
zz Width/Radius Ratio: 0.01 to 1.20
zz Flattening: 0.50 to 2.00
zz Azimuth: –45.0 to 45.0
zz V Balance: –60 to 60
zz Rotation [degree]*: –10.0 to 10.0
It may not be possible to correct the images depending on how the settings are used in combination, such as a small
lens throw ratio (lens with a short focus) and keystone correction with a wide angle.
*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
“Activation” (page 12)

④

Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.
When a check mark is entered for
, the image is reduced to a size in which it can be projected when it exceeds
the projection area.
The image will not be reduced if a check mark is not entered.

⑤

Maintain Aspect Ratio
When a check mark is entered for
Aspect Ratio, correction is made so that the aspect ratio of the
projected image is maintained.
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the
display device.
This function can be used only for projectors that have this function.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
“Activation” (page 12)
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 Description of elliptical screen (elliptical shape correction) parameters
View of projector as seen from above
Tangent

Width/Radius Ratio

Screen
H Keystone [degree]

Azimuth

Flattening

Projector

Horizontal radius of
ellipsis

Example of settings
Setting item

Calculation method

Lens Throw Ratio

Setting

Projection distance ÷ width of image on flat screen
= 3 870 mm ÷ 4 300 mm

0.9

H Keystone [degree]

Angle formed with tangent of projection center

14.0

Width/Radius Ratio

Width of image on flat screen ÷ radius in horizontal direction of ellipsis
= 4 300 mm ÷ 6 200 mm

0.69

Flattening

Radius in vertical direction of ellipsis ÷ radius in horizontal direction of ellipsis
= 4 110 mm ÷ 6 200 mm

0.66

Azimuth

Position of projected image center on ellipsis

40.0

Tangent

4 300 mm

14°
40°

Projector

6 200 mm
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Spherical screen (spherical correction)
Images are corrected using the spherical shape as the reference with this type of correction.

①

①

②

③

②

④

⑤

Correction pattern adjustment area
The following settings are selected here:
zz Vertical arc and horizontal arc: –100 to 100*1 (–50 to 50)*2
*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
“Activation” (page 12)

②
③

Reset
Use these to reset the settings that have been changed.
Setting
The following settings are selected here:
zz Lens Throw Ratio: 0.7 to 16.5
zz V Keystone [degree]: –45.0 to 45.0*1 (–40.0 to 40.0)*2
zz H Keystone [degree]: –40.0 to 40.0*1 (–15.0 to 15.0)*2
zz V Arc: –100 to 100*1 (–50 to 50)*2
zz V Balance: –60 to 60
zz H Balance: –30 to 30
zz Rotation [degree]*: –10.0 to 10.0
*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
“Activation” (page 12)

④

Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.
When a check mark is entered for
, the image is reduced to a size in which it can be projected when it exceeds
the projection area.
The image will not be reduced if a check mark is not entered.

⑤

Maintain Aspect Ratio
When a check mark is entered for
, correction is made so that the aspect ratio of the projected
image is maintained.
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the
display device.
This function can be used only for projectors that have this function.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
“Activation” (page 12)
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Geometry Correction

Rotation (rotation correction)
Images are rotated with this type of correction.
To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector.
“Activation” (page 12)

①

①

②

③

②

④

Correction pattern adjustment area
The following settings are selected here:
zz Gradient: –10.0 to 10.0

②
③

Reset
Use these to reset the settings that have been changed.
Setting
The following settings are selected here:
zz Rotation [degree]: –10.0 to 10.0

④

Fit Size
Projected images sometimes protrude beyond the projection area when they are rotated.
When a check mark is entered for
, the image is reduced to a size in which it can be projected when it exceeds
the projection area.
The image will not be reduced if a check mark is not entered.
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S-shape screen (S-shaped correction)
Images are corrected using an S-shape as the reference with this type of correction.

①

①

②

Correction pattern adjustment area
The following settings are selected here:
zz S-shaped correction: –127 to 127

②

Reset
Use these to reset the settings that have been changed.
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Edge Blending

Edge Blending
Edge Blending screen
⑱

①

② ③

⑮

⑯

⑰
④
⑧
⑨
⑩
⑪
⑫
⑬

⑤

⑦
⑭
⑥

①

Mode Switching
OFF:
The edge blending settings are canceled.
ON:
Makes the edge blending settings effective.
User:
Adjusts settings for edge blending using the user-defined curve.

Note
When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the
Upper, Lower, Left and Right Enable boxes.

②

Marker
When a check mark is entered in
, markers are displayed in the editing area and on the images projected from
projector.
The start position for edge blending is indicated by display of a green line, and the edge blending width is indicated by
display of a red line.
“Editing Area” (page 58)

③
④

Setting
Click this button to display the user-defined curve setting screen.
“User-defined curve setting screen” (page 59)
Upper
The upper side settings of the projected image are set here.
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⑤
⑥
⑦
⑧

Edge Blending

Left
The left side settings of the projected image are set here.
Right
The right side settings of the projected image are set here.
Lower
The lower side settings of the projected image are set here.
Enable
to create blending settings for that edge. Only the edge blending settings for
Put a check mark is entered in
those items with a check mark entered in
take effect.

Note
When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the
Upper, Lower, Left and Right Enable boxes.

⑨
⑩
⑪
⑫
⑬

⑭

Start
The starting position of edge blending is set here.
Width
The width of the edge blending is set here.
Black Border (Outside Area)
Set the border width of the black level.
[Outside Area] may be displayed in place of [Black Border] for some models.
Keystone Area
Set the slope of the black level border when using the edge blending at the same time as the keystone correction.
This function can be used only for projectors that have this function.
Overlapped Black Level (Bright Blending)
The Red, Green and Blue values are adjusted here to set the brightness of the areas subject to edge blending.
These settings are applied to the edge blending width. The higher the numerical value, the brighter the colors.
Setting range: 0 to 255
[Bright Blending] may be displayed in place of [Overlapped Black Level] for some models.
Interlocked
When a check mark is entered for
all linked together.

⑮

, Overlapped Black Level can be set with the Red, Green and Blue values

Non-Overlapped Black Level (Bright Inside)
The black level inside the area where the images are to be superimposed is set here.
When a check mark is removed from
, the Red, Green and Blue values can be set separately.
[Non-Overlapped Black Level] may be displayed in place of [Bright Inside] for some models.

⑯

Black Border Level (Bright Outside)
Set the black level of the parts where images are superimposed.
When a check mark is removed from
, the Red, Green and Blue values can be set separately.
[Black Border Level] may be displayed in place of [Bright Outside] for some models.
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⑰

Edge Blending

Editing Area
The edge blending setting status is displayed here.
By dragging these markers, the start position of the edge blending (green), edge blending width (red), and black level
border width (yellow) can be set.
The settings established with Upper, Left, Right and Lower are also reflected in this area.

Note
The line for the black level border width (yellow) is displayed only when the mouse cursor is positioned on the marker
(yellow).
Start (Edge blending start position)

Black Border (Black level border width)
Width (Edge blending width)

⑱

Edit
In addition to the menu items described in “Main menu” (page 26), the following menu items can be used on the Edge
Blending screen.

Edit submenu
Flip Vertical:
Click to flip vertically the correction status of the entire image.
Flip Horizontal:
Click to flip horizontally the correction status of the entire image.
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Edge Blending

User-defined curve setting screen
When [Setting] is clicked, the user-defined curve setting screen is displayed.
The gradient (brightness gradient) at which edge blending is performed is set using a gamma curve.
When a user-defined curve setting is changed from the initial curve, the display above [Setting] changes from [User Blending
Curve: Default] to [User Blending Curve: Changed].

A
①
B
②
C
③

④
D
E
⑤

F
⑥
G
⑦
H
⑧
I
⑨
J
⑩

①
②
③
④
⑤
⑥
⑦

Blending
The position where the user-defined curve is to be set is selected here.
Copy
Click this to copy the current user-defined curve setting.
The setting is copied from top to bottom (or vice versa) or from left to right (or vice versa).
Gamma
The user-defined curve is set here.
For numerical value input: Enter a setting from 0.25 to 4.00 (in 0.01 steps).
Initial Curve
The initial setting of the user-defined curve is displayed here.
Correction Curve
The operation point in the center can be dragged to change the user-defined curve setting (shape of the gamma curve).
Store
Click this to reflect the currently displayed user-defined curve setting in the projector and save the setting in the projector.
The setting remains saved even when the main power of the projector has been set to “off”.
Reset
Click this to reset the currently displayed user-defined curve setting and return it to the initial value.
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⑧

Edge Blending

OK
Click this to reflect the user-defined curve setting in the projector and close the user-defined curve screen.
.

This operation is reflected in the projector even when a check mark has not been entered in

⑨

Apply
Click this to reflect the user-defined curve setting in the editing area.
This operation is reflected in the projector even if a check mark has not been entered for

⑩

Cancel
Click this to cancel the setting and close the user-defined curve screen.
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Uniformity

Uniformity
Two correction methods can be used for uniformity.

 Gradient Correction
When unevenness in color occurs in one direction across the image, greater uniformity can be obtained by applying
correction in the vertical or horizontal direction.
Correction is performed by toning down (thinning) the selected color in a gradient-like manner from one side of the image to
the other.

 Flexible Correction
Flexible Correction is enabled by entering a check mark in
.
When the image contains localized unevenness in color, correction is applied after specifying the range.
As with Gradient Correction, correction is performed by toning down (thinning) the selected color in a gradient-like manner.
“Flexible Correction Procedure” (page 64)
To use the Flexible Correction function, the upgrade kit (ET-UK20) must be applied on the selected projector.
“Activation” (page 12)

Uniformity screen
⑬

① ②③

④

⑦

⑨
⑪

⑩

①

⑧

⑫

⑥

⑤

⑧

Sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
The Sub Window displays a representation of the Gradient Correction and Flexible Correction settings for the entire
projection area.
 Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.
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②
③
④
⑤

⑥

Uniformity

Zoom In
Zooms in to the editing area.
The center of the target area is zoomed in when the target area has been selected in the editing area.
Zoom Out
Zooms out the editing area.
Editing Area
A representation of the Gradient Correction and Flexible Correction settings is displayed.
When applying Flexible Correction, this is where you select target points and set the target area.
Gradient Correction
When applying gradation to the entire image, set the degree of color variation.
You can set this individually for each of the colors White, Red, Green and Blue, both for the vertical direction (V) and the
horizontal direction (H).
For numerical value input: Enter a value from -127 to 127.
 How the vertical (V) and horizontal (H) gradation slopes varies depending on the model. For details, refer to “Settings”
- “[DISPLAY OPTION] menu” - “[UNIFORMITY]” in the operating instructions of the projector.
Display on PC
When you put a check in
, the Gradient Correction settings are applied in the editing area.
Put a check here when you want to see the combined effect of Gradient Correction settings and Flexible Correction
settings in the editing area.
When the check is removed from
, the Gradient Correction settings are not applied to display in the editing
area. The settings will still be reflected in the projector, however.

⑦
⑧
⑨

Lamp Status
When a projector that uses a lamp as light source is selected, this indicates the lamps that are currently lit.
[None] is displayed if none of the lamps is lighted.
Reset
Return the Gradient Correction and Flexible Correction settings to their default values.
Enable*
When a check mark is entered in

, the Flexible Correction settings are enabled.

Right-clicking
, the following menu
If the mouse is right-clicked in the editing area when a check mark has been entered in
items are displayed. The functions of these items are the same as with the Edit submenu items.
“Edit submenu” (page 63)
Reset, Flip Vertical, Flip Horizontal, Area Select, Point Select

⑩

⑪

Flexible Correction
When correcting partial unevenness in image color, you can set the degree of the change in the gradation color to be
applied to the area surrounding the selected target point.
This setting can be made individually for each of the three colors Red, Green, and Blue.
Setting range: 0 to 1023
Interlocked
By putting a check in
and Blue.

, you can set Flexible Correction to link the value set to all three of colors Red, Green,

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
“Activation” (page 12)
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⑫
⑬

Uniformity

Store
Reflects the gradation settings in the projector and saves them in the projector.
The settings are maintained even when the main power of the projector has been turned off.
Edit
In addition to the menu items described in “Main menu” (page 26), the following menu items can be used on the
Uniformity screen. However, these menu items are valid only when the Flexible Correction method is used for correction.

Edit submenu
Reset
Return the Gradient Correction and Flexible Correction settings to their default values.
This item cannot be selected when [Area Select] has been selected.
Neither can it be selected when the target area has not been set.
Flip Vertical
Click to flip vertically the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.
Flip Horizontal
Click to flip horizontally the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.
Area Select
While an area is selected, its control points are displayed.
The target area can be enlarged or reduced or moved using the control points.
zz [Area Select] cannot be selected concurrently with Point Select.
Point Select
Confirms settings for the target area currently being set.
zz [Point Select] cannot be selected concurrently with Area Select.
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Flexible Correction Procedure
Select the target point from which gradation is to be applied, and then specify the target area (the range to be corrected) and
apply correction. When doing this, specify the points at which grid lines cross as target points.
Editing area
Target point

Target area

Operation point

1
2

3
4

Place a check in

to enable Flexible Correction settings.

Click or drag the mouse to select a target point.
You can also select multiple target points at the same time.
A red frame is displayed around the perimeter of the area defined by the selected target points, and this becomes the
target area (the correction area).
*	The target area and target point can be selected using the same method as for the control points of the geometry
correction grid.
“Selecting the control points” (page 44)
Adjust the parameters.
Gradation is applied to the selected color in the target area defined by the target points is such a manner that the color is
toned down toward the periphery of the area.
Right-click and select [Area Select], and display the operation points (green) in the target area.
Using the mouse, drag the operation points to enlarge or reduce the size of the target area.
If the mouse cursor is placed in the target area and then dragged, the target area can be moved.
zz [Area Select] can also be selected on the Edit submenu.

Note

5

Enlarging or reducing the size of the target area does not change the number of selected target points.
Right-click to select [Point Select], and release the operation point display.
zz [Point Select] can also be selected on the Edit submenu.

Note

6

[Point Select] and [Area Select] can be toggled by pressing the space key.
Repeat the above steps when you want to apply correction to multiple target areas.
Where the target areas overlap, correction will be applied by multiplying the respective settings.
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Brightness Control

Brightness Control
When a single image is configured using a multiple number of projectors, the brightness levels of the images projected from
the projectors may not be consistent. If this is the case, adjust the projectors so that the brightness levels are made consistent.
The brightness correction can also be done automatically at periodic intervals.

Brightness Control screen

①

②
③
④
⑤
⑥

⑦

⑧
⑨

①

The items displayed will vary depending on the projector you are using.
Brightness Control Gain

This is where the projector brightness is set.
The brightness of the image projected from the projectors is set according to the numerical value that is set here.
Operating Mode

This is where the operating mode of the projector is set.
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Brightness Control

Normal:
Select this when a high level of brightness is required.
Eco:
This mode produces a lower brightness than in [Normal] mode, but extends the life of the light source.
Long Life1/Long Life2/Long Life3:
These modes produce a lower brightness than in [Eco] mode, but extend the life of the light source.
User1/User2/User3:
These modes allow you to configure separate [Max Light Output Level] and [Light Output] settings.
Max Light Output Level:
This allows you to adjust the upper limit for brightness correction of the screen based on the change in brightness of
the light source.
Light Output:
This allows you to adjust the brightness of the light source.
For details, refer to the operating instructions of the projector.

②

Mode
This is where the brightness correction mode is selected.
OFF:
The brightness is not corrected.
Auto:
The brightness levels of the images projected from the projectors are corrected by the brightness sensors of the
projectors.
For details, refer to the operating instructions of the projectors concerned.
PC:
The brightness levels of the images projected from the projectors are corrected using the “Multi Monitoring &
Control Software”.
For details, refer to the Operating Instructions of “Multi Monitoring & Control Software”.

③

Link
This is where the link mode is set.
The mode is enabled when [Auto] has been selected as the Mode setting.
OFF:
The brightness level of the selected projector is corrected.
Group A/Group B/Group C/Group D:
The brightness levels of the projectors in the respective group are corrected.
The groups are set using the network function of the projectors.
For details, refer to the operating instructions of the projectors.

④

Calibration Message
When a check mark is entered for
correcting the brightness.

⑤

Chroma Correction
When a check mark is entered for
Some models do not support this function.

⑥

, a message is displayed while measuring the brightness levels for

, color is adjusted together with brightness.

Calibration Time
The time at which to start measuring the brightness levels for correcting the brightness is selected here.
.

The time can be set when a check mark is entered for

⑦

Apply
Click this to reflect the brightness control setting in the projector.
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⑧

Status
Brightness correction-related errors are displayed here.
Status

Error
Brightness sensor error

Description
Something is wrong with the brightness sensor (projector).

The brightness cannot be measured.
Please check the status of the projector.

The brightness cannot be corrected due to a factor that is not
related to the brightness sensor.

Yellow

The brightness can no longer be
corrected by a significant margin.

The brightness that can be corrected by the projector is
reaching its limit.

Green

No Error

Normal condition.

Red

⑨

Brightness Control

Update
Click this button to check the projectors and update the Status displays.
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Color Matching

Color Matching
When configuring a single image using a multiple number of projectors, the coloring of the image projected from the various
projectors may not be consistent. If this is the case, adjust the projectors to match the coloring.

Color Matching screen

①
②

③

④

⑤

Note
The items that can be adjusted, setting details, and setting range vary depending on the model.

①

Mode
The color matching mode is selected here.
OFF
Color matching is not performed.
3 Colors
The inconsistencies in the colors are corrected by adjusting three colors (Red, Green and Blue).
7 Colors
The inconsistencies in the colors are corrected by adjusting seven colors (Red, Green, Blue, Cyan, Magenta, Yellow
and White).
709 Mode
The brightness (Y) and chrominance coordinate (x, y) values are adjusted here based on the values obtained using
a coloring chromoscope capable of measuring chrominance coordinates and brightness levels.
The Target Data values are fixed.
709 Mode cannot be selected for some models. For details, refer to the Operating Instructions of the projector.
Measured
The brightness (Y) and chrominance coordinate (x, y) values are adjusted here based on the values obtained using
a coloring chromoscope capable of measuring chrominance coordinates and brightness levels.
The Target Data values can be adjusted.
For details, refer to the Operating Instructions of the projector.
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②

③
④
⑤

Color Matching

3 Colors
The Red, Green and Blue values are set here.
The settings take effect when [3 Colors] has been selected as the Mode setting.
The White value can be set in addition to the Red, Green and Blue values for some models.
7 Colors
The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here.
The settings take effect when [7 Colors] has been selected as the Mode setting.
Measurement Data
The Black, Red, Green, Blue and White values are set here.
The settings take effect when [709 Mode] or [Measured] has been selected as the Mode setting.
Target Data
The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here.
The settings take effect when [Measured] has been selected as the Mode setting.
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Masking

Masking
Two kinds of masking are available.
To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector.
“Activation” (page 12)

 Line Masking
The shape to be masked is set by moving the operation points on the four sides–top, bottom, left and right–of the projected
image.
The area to be masked can also be inverted between positive and negative.

 Bitmap Masking
The bitmap in the 1-bit monochrome format is loaded and set as the masking data.
The position and size of the masking can be changed.
Bitmaps from 8 x 8 pixels to 1920 x 1200 pixels (when the resolution of the projector is 1920 x 1200 dots or 1400 x 1050
dots) or 3840 x 2400 pixels (when the resolution is other than the aforementioned) are supported.
The *.bmp and *.dib file extensions are supported.
The area to be masked can also be inverted between positive and negative.

Note
zz The Line Masking and Bitmap Masking settings can be used simultaneously. In that case, masking applies to the each area
set in the settings.
zz When the input signal of the projector is changed, retransmission to the projector may be required.

Masking screen
⑩

① ② ③ ④ ⑤⑥ ⑦

⑧

⑨
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①

②
③
④
⑤
⑥
⑦
⑧

Masking

Sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
An image of the entire projection area is displayed on Sub Window.
 Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.
Zoom In
Zooms in to the editing area.
Zoom Out
Zooms out the editing area.
Red
Selects whether the operation points on the left side of the projected image are to be displayed or not displayed.
 This performs the same operation as [Mask Marker] – [Red] on the View submenu.
Blue
Selects whether the operation points at the top of the projected image are to be displayed or not displayed.
 This performs the same operation as [Mask Marker] – [Blue] on the View submenu.
Green
Selects whether the operation points on the right side of the projected image are to be displayed or not displayed.
 This performs the same operation as [Mask Marker] – [Green] on the View submenu.
Orange
Selects whether the operation points at the bottom of the projected image are to be displayed or not displayed.
zz This performs the same operation as [Mask Marker] – [Orange] on the View submenu.
Editing Area
Click the operation points to select them, and then drag them to form the shape that is to be masked.
Right-clicking
Clicking the right-mouse button in the editing area displays a menu with following items. The menu functions are the
same as with the Edit submenu.
“Edit submenu” (page 72)
Reset, Flip Vertical, Flip Horizontal

⑨

Mode Switching
OFF: Masking is not performed.
PC-1 / PC-2 / PC-3: Masking is enabled.

Note
When masking is enabled, only one piece of data (PC) can be saved for some models.
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⑩

Masking

Edit, View
In addition to the menu items described in “Main menu” (page 26), the following menu items can be used on the
Masking screen.

Edit submenu
Reset
When Line Masking has been performed, the positions of the operation points are returned to their initial
statuses.
Returns to the status established when the bitmap has been loaded when Bitmap Masking is executed.
Flip Vertical
Click to flip vertically the correction status of the entire image.
Flip Horizontal
Click to flip horizontally the correction status of the entire image.

View submenu
Mask Marker (Red, Green, Blue, Orange)
Selects whether the operation points are to be displayed or not displayed.
The non-displayed operation points are fixed at the positions when the selection was made not to display them.
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Masking

Line Masking

①

①

⑤

②

③

④

Left
When a check mark is entered for
enabled.

②

Upper
When a check mark is entered for
enabled.

③

, masking based on the operation point on the right side of the projected image

Lower
When a check mark is entered for
enabled.

⑤

, masking based on the operation point at the top of the projected image is

Right
When a check mark is entered for
is enabled.

④

, masking based on the operation point on the left side of the projected image is

, masking based on the operation point at the bottom of the projected image is

Invert
When a check mark is entered for

, the Line Masking area can be inverted between positive and negative.
Upper operation point (Blue)

Right operation point (Green)

Left operation point (Red)

Lower operation point (Orange)
The operation points at both ends of a side can be moved around the outer circumference (along the four sides) of the
image.
When an operation point at the center of a side is moved, it can be moved without changing the angle of the straight line
that connects the operation points at both ends of the side.
When the operation points have been selected, they can also be moved by operating the cursor keys on the keyboard.
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Masking

Bitmap Masking

②

①

①

File
Click this button to open the screen on which to select the bitmap data used for masking.
Using the bitmap data which has been loaded, mouse operations can be used to move, enlarge or reduce the masking
area.
The bitmap data can be moved, enlarged, or reduced in a display area with a resolution of 2880 x 1800 pixels (when the
resolution of the projector is 1920 x 1200 dots or 1400 x 1050 dots) or 5760 x 3600 pixels (when the resolution is other
than the aforementioned).
If [File] is clicked when the bitmap data for masking has already been loaded, the previously loaded bitmap data is
discarded and the new loaded bitmap data is set for masking.

②

Invert
When a check mark is entered for

, the Bitmap Masking area can be inverted between positive and negative.

Bitmap data (example)
Drag to move.

When the center point here is dragged, the masking area
can be enlarged or reduced horizontally or vertically.

When a point in one of the four corners is dragged, the
masking area can be enlarged or reduced without changing
the aspect ratio.
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Input Signal Adjustments

Input Signal Adjustments
Projectors normally identify the input signals automatically, but if unstable signals are to be input, this software application
allows the format matching the input signals to be selected, position adjustments to be made, and so on by manual means.

Input Signal screen
①

⑤
⑧
⑥
⑦
②
③
④

①

⑨
⑩

Input Select
These are used to select the input.
Click the input (selector) button of the signals to be projected.
The inputs that can be selected vary depending on the model. For a model equipped with slots, the buttons are enabled
only for the slots with boards inserted, and the inputs that can be selected are displayed on the buttons.

This operation is reflected in the projector even if a check mark has not been entered for
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②

Input Signal Adjustments

System Selector
The system format which matches the input signals is selected here.
The formats which can be selected differ depending on the projector model, input signals and input connectors.
Input Select
RGB1, Y/C or
RGB1, Y/C, Video

System Selector
When [RGB/YPbPr] is selected*1
RGB / VGA60
YCbCr / YPbPr / 480p YCbCr
480p RGB
RGB / 640x480/60p
YCbCr / YPbPr / 480/60p YCbCr
480/60p RGB

RGB2

RGB / VGA60
YCbCr / YPbPr / 480p YCbCr
480p RGB
RGB / 640x480/60p
YCbCr / YPbPr / 480/60p YCbCr
480/60p RGB

Video

Auto
NTSC
NTSC4.43
PAL
PAL-M
PAL-N
SECAM
PAL60

DVI-D

RGB
YCbCr / YPbPr

HDMI

Auto
RGB
YCbCr / YPbPr

Digital Link

Auto
RGB
YCbCr / YPbPr

When [Y/C] or [Video] is selected*1
Auto
NTSC
NTSC4.43
PAL
PAL-M
PAL-N
SECAM
PAL60
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Input Signal Adjustments

Input Select
SDI1 or SDI

System Selector
When [Single Link] is selected*2
Auto
480i YCbCr
480/60i YCbCr
576i YCbCr
576/50i YCbCr
720/50p YPbPr
720/60p YPbPr
1035/60i YPbPr
1080/24p YPbPr
1080/24sF YPbPr
1080/25p YPbPr
1080/30p YPbPr
1080/50i YPbPr
1080/60i YPbPr
1080/50p YPbPr
1080/60p YPbPr
1080/24p RGB
1080/24sF RGB
1080/25p RGB
1080/30p RGB
1080/50i RGB
1080/60i RGB
2K/24p RGB
2K/25p RGB
2K/30p RGB
2K/48p RGB
2K/50p RGB
2K/60p RGB

SDI2

When [Single Link] is selected*2
Auto
480i YCbCr
576i YCbCr
720/50p YPbPr
720/60p YPbPr
1035/60i YPbPr
1080/24p YPbPr
1080/24sF YPbPr
1080/25p YPbPr
1080/30p YPbPr
1080/50i YPbPr
1080/60i YPbPr
1080/50p YPbPr
1080/60p YPbPr
1080/24p RGB
1080/24sF RGB
1080/25p RGB
1080/30p RGB
1080/50i RGB
1080/60i RGB

When [Dual Link] is selected*2
Auto
1080/24p RGB
2K/24p RGB
2K/24p XYZ
1080/24sF RGB
2K/24sF RGB
2K/24sF XYZ
1080/25p RGB
1080/30p RGB
1080/50i RGB
1080/60i RGB
1080/50p RGB
1080/60p RGB
1080/50p YPbPr
1080/60p YPbPr
2K/48p RGB
2K/50p RGB
2K/60p RGB
2K/48p YPbPr
2K/50p YPbPr
2K/60p YPbPr

When [Auto] is selected*2
Auto

When [Dual Link] is selected*2
Auto
1080/24p RGB
2K/24p RGB
2K/24p XYZ
1080/24sF RGB
2K/24sF RGB
2K/24sF XYZ
1080/25p RGB
1080/30p RGB
1080/50i RGB
1080/60i RGB
1080/50p RGB
1080/60p RGB
1080/50p YPbPr
1080/60p YPbPr
2K/48p RGB
2K/50p RGB
2K/60p RGB
2K/48p YPbPr
2K/50p YPbPr
2K/60p YPbPr

When [Auto] is selected*2
Auto

*1 In the Other screen, select with [Display Option] - [RGB In] - [RGB1 Input Setting].
*2 In the Other screen, select with [Display Option] - [SDI In] - [SDI Link].
“Display Option” (page 82)

Note
zz For models that do not support dual link HD-SDI signals, the system format that can be selected when [SDI1], [SDI],
or [SDI2] is selected with [Input Select] is the same as for [Single Link].
zz Even if an [Input Select] button shown in the table above is selected, the function may be disabled depending on the
projector you are using.
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③

Input Signal Adjustments

Aspect
The aspect ratio of the images is selected here. The aspect ratios that can be selected are listed below:
zz Default / Auto / VID Auto
zz Through
zz 16:9
zz 4:3
zz H FIT
zz V FIT
zz HV FIT
For details, refer to the operating instructions of the projectors.

④

⑤

Clock Phase
Image flickering and contour blurring are adjusted here.
Input value range: 0 to 31
However, they cannot be adjusted when Y/C signals have been selected as the input signals.
For details, refer to the operating instructions of the projectors.
Zoom Mode
The zoom mode is selected here.
The setting is enabled when [Default / Auto / VID Auto] has been selected as the Aspect setting.
The modes that can be selected are listed below:
zz Internal
zz Full
For details, refer to the operating instructions of the projectors.

⑥
⑦
⑧

Vertical (Zoom)
The zoom magnification in the vertical direction is set here.
Input value range: 50 to 999
Horizontal (Zoom)
The zoom magnification in the horizontal direction is set here.
Input value range: 50 to 999
Interlocked
When a check mark is entered for
vertical directions.

⑨
⑩

, the same zoom magnification can be set in both the horizontal and

Vertical (Shift)
The vertical position of the projected image is set here.
The input value range varies depending on the projector model.
Horizontal (Shift)
The horizontal position of the projected image is set here.
The input value range varies depending on the projector model.

Note
The Input Signal screen items cannot be reset with the [Reset Data (Current Tab)] command on the File submenu and icon
menu.
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Projector Menu Settings

Projector Menu Settings
Some of the operations using the projector’s menus can be performed using this software application.

Other screen
①

①
②
③
④
⑤

②

③

④

⑤

Picture
Click to display the Picture screen.
The video mode, black level and other settings related to the image adjustments can be selected.
Advanced Menu
Click to display the Advanced Menu screen.
The blanking width, input resolution and other settings can be selected.
Display Option
Click to display the Display Option screen.
The color correction, aspect ratio and other settings related to the image display used for large screens can be selected.
Projector Setup
Click to display the Projector Setup screen.
The projector’s projection system, lamp selection and other hardware settings can be established.
The items displayed will vary depending on the projector you are using.
P in P
Click to display the P in P screen.
The positions and sequence of priority for the main screen and sub screens as well as other P in P functions can be set.
Multi Display
The inputs for 4-split display, frame lock, and other settings for the multi screen function can be set.
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Projector Menu Settings

 Picture

The following items can be set:
Picture Mode **
Contrast
Brightness
Color
Tint
Sharpness
Noise Reduction
Waveform Monitor
Line Position
Color Temperature
White Balance Red High
White Balance Green High
White Balance Blue High
White Balance Red Low
White Balance Green Low
White Balance Blue Low

Gamma
System Daylight View
Dynamic Iris
Auto Iris
Manual Iris
Dynamic Gamma
Dynamic Contrast
Auto Contrast
Bright Signal Level
Lights Out Timer
Lights Out Signal Level
Manual Intensity
Dynamic Gamma
AI
White Gain
Color Space

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

Note
.
zz Items marked ** are reflected in the projector even when a check mark has not been entered in
zz The Picture screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon
menu.
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Projector Menu Settings

 Advanced Menu

The following items can be set:
Digital Cinema Reality
Blanking
Upper
Left
Right
Lower
Input Resolution
Total Dots
Display Dots
Total Lines
Display Lines
Clamp Position
Frame Response
Frame Creation
Frame Creation Mode
Film Detection
Raster Position
Vertical
Horizontal
Quad Pixel Drive
The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

Note
The Advanced Menu screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and
icon menu.

81

Adjustment and Settings

Projector Menu Settings

 Display Option
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Projector Menu Settings

The settings of the items listed below can be established and operated.
Large Screen Correction
Screen Setting
Screen Format
Vertical Position *
Horizontal Position *
Auto Signal
Auto Setup
Mode
Display Dots *
Position Adjust
Signal Level Adjust
Execute
Background Color
Startup Logo
Cut Off
Red
Green
Blue
Image Rotation
Closed Caption Setting
Shutter Setting
Mechanical Shutter
Fade-In
Fade-Out
Startup
Shut-Off
On-Screen Display
OSD Position
OSD Size
OSD Rotation
OSD Design
OSD Memory
Input Guide
Warning Message

Color Correction
Red
Green
Blue
Cyan
Magenta
Yellow
Backup Input Setting
Backup Input Mode
Automatic Switching
Simul Input Setting
RGB1/RGB2
HDMI/DVI-D
SDI1/SDI2
SDI In
Slot In
SDI In
SDI Link
SDI1 Signal Level
SDI1 Bit Depth
SDI1 3G-SDI Mapping
SDI2 Signal Level
SDI2 Bit Depth
SDI2 3G-SDI Mapping
Dual Link Signal Level
Dual Link Bit Depth
Dual Link 3G-SDI Mapping
Target Input
(The selection options of the
following adjustment items
vary depending on the selected
setting.)
Resolution
4K Division
3G-SDI Mapping
System Selector
Color Space
Sampling
Bit Depth
Signal Level

Digital Link In
Digital Link Signal Level
Digital Link EDID Select
Digital Link EDID Mode
Digital Link EDID Resolution
Digital Link EDID V Scan Freq.
Signal Level
EDID Select
EDID Mode
EDID Resolution/V Scan Freq.
RGB In
RGB1 Input Setting
RGB1 Sync Slice Level
RGB2 Sync Slice Level
RGB2 EDID Select
RGB2 EDID Mode
RGB2 EDID Resolution
RGB2 EDID V Scan Freq.
DVI-D In
DVI EDID
DVI Signal Level
DVI EDID Select
DVI EDID Mode
DVI EDID Resolution
DVI EDID V Scan Freq.
HDMI In
HDMI Signal Level
HDMI EDID Select
HDMI EDID Mode
HDMI EDID Resolution
HDMI EDID V Scan Freq.
Slot In
Link Select **
Link Setting ***
EDID Setting ***

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

Note
zz Items marked with an asterisk (*) cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and
icon menu.
zz Items marked ** are switched automatically depending on whether a board is inserted in the slot and the type of board if a
board is inserted.
zz Items marked *** are switched automatically depending on setting of Link Select.
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 Projector Setup

The settings of the items listed below can be established and operated.
Projection Method
Cooling Condition
High Altitude Mode
Lamp Select *
Lamp Relay
Time
Standby Mode
Quick Startup
Valid Period
No Signal Shut-Off
No Signal Lights-Off
Initial Startup
Startup Input Select
AC Voltage Monitor
Date and Time
Time Zone *
Synchronize to PC **
(The projector’s clock setting is synchronized with the computer.)
Multi Projector Sync
Mode
Contrast Sync
Shutter Sync
The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

Note
zz Items marked with an asterisk (*) cannot be reset using the [New All Data] and [New Data (For Current Window)] commands
on the File submenu and icon menu.
zz Items marked ** are reflected in the projector even when a check mark has not been entered in
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Projector Menu Settings

 P in P

The following items can be set:
P in P Mode **
Frame Lock
Type
Main Window
Input Signal
Size
Interlocked
Vertical
Horizontal
Position
Vertical
Horizontal

Sub Window
Input Signal
Size
Interlocked
Vertical
Horizontal
Position
Vertical
Horizontal
Clock Phase

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

Note
.
zz Items marked ** are reflected in the projector even when a check mark has not been entered in
zz The P in P screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon
menu.
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Projector Menu Settings

 Multi Display

The following items can be set:
Multi Display Mode **
Frame Lock
Upper Left Window
Lower Left Window
Upper Right Window
Lower Right Window
The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

Note
.
zz Items marked ** are reflected in the projector even when a check mark has not been entered in
zz The Multi Display screen items cannot be reset with the [Reset Data (Current Tab)] command on the File submenu and icon
menu.
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Auto Screen Adjustment
Applying the ET-CUK10/CUK10P Auto Screen Adjustment upgrade kit to the projector expands the functions of Geometry
Manager Pro, and allows automatic adjustment of geometry correction, edge blending, color and brightness correction, and
adjustment of white balance according to the shape of the screen through use of an externally connected camera.
After performing Auto Screen Adjustment, you can perform further detailed adjustment and correction manually.

Note
zz The Auto Screen Adjustment upgrade kit is required to enable the Auto Screen Adjustment function.
Product Number

Product Name

Description

ET-CUK10

Auto Screen Adjustment
Upgrade Kit

Activating on each projector enables the “Auto Screen Adjustment plug-in software”
functions.

ET-CUK10P

Auto Screen Adjustment
Upgrade Kit (PC)

Activating on a computer on which the software is installed enables the “Auto Screen
Adjustment plug-in software” functions.

“Activation” (page 12)
zz You can check whether the Auto Screen Adjustment plug-in software is installed and the activation status of the Auto
Screen Adjustment upgrade kit (PC) in [About Geometry…] of the Version submenu.
zz To use the Auto Screen Adjustment function, prepare a camera separately.
zz Use a LAN connection when using the Auto Screen Adjustment function.

Preparing Auto Screen Adjustment
 Projector connection
Use a LAN cable to connect the projector to the computer.

Note
Auto Screen Adjustment cannot be performed via a serial (RS-232C) connection.

 Camera connection
Use a USB cable to connect the camera to the computer.
For details on compatible cameras, check the information found on the software download page after logging in to PASS on
the Panasonic website (http://panasonic.net/avc/projector/pass/).

 Connection example

Computer

USB connection

LAN
connection

Projectors

Camera

Hub
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Compatible screens for Auto Screen Adjustment

Note
zz Positioning the camera so that it faces the screen directly and performing adjustments will obtain more optimal adjustment
results. Adjustment is possible when the camera is facing the screen at an angle but may fail if the angle is too large.
zz In cases such as the following, adjustment is possible using multiple cameras (up to 6).
- When the projector layout configuration has 5 or more projectors in the vertical or horizontal direction.
- When the entire screen does not fit in the capture range of 1 camera.

Compatible screens for Auto Screen Adjustment
Auto Screen Adjustment may not be performed properly depending on the shape of the screen. If adjustment is not performed
properly, perform adjustments manually.

Compatible screens

Non-compatible screens

zz Flat

zz Folded

Folded screen type

zz Curved screen

Curved in one direction

* Individual adjustments for each side are
possible.

Curved in two directions

zz Curve changes smoothly

S-curve

Variable curve type

zz 360-degree curved screen
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Operation flow for Auto Screen Adjustment

Operation flow for Auto Screen Adjustment
Settings for Auto Screen Adjustment are configured in a wizard format.
Adjustment items selection

Projector Layout
Projector layout settings
Projector selection and positioning

Camera Setting
Camera connection and layout
Camera settings

Projection Setting
Geometry
Edge Blending

Color Matching

Auto Screen Adjustment complete
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White Balance

Auto Screen Adjustment

Auto Screen Adjustment procedure

Auto Screen Adjustment procedure
Starting Auto Screen Adjustment and selecting the adjustment item

1

Click the [AUTO ADJUST] button in the main screen.

2

Click the items you want to adjust.

Adjustment items selection screen
zz You can select from following four options
- [Geometry, Edge Blending, Color Matching]
- [Geometry, Edge Blending]
- [Color Matching]
- [White Balance]
By clicking the [Re-adjust] button to the right of each option, you can restore it to the setting that it had previously.
“Readjust by recalling previous settings” (page 91)
zz The subsequent steps and screens that appear in the procedure will vary depending on the selected items.

Note
zz Make sure the projector is turned on before starting Auto Screen Adjustment. Proper correction will not be possible if the
projector is in the standby state.
zz When performing automatic screen color, brightness and white balance correction, do so in an environment where
impact from external lighting will be low.
zz While setting Auto Screen Adjustment, a progress indicator will appear at the top right of each screen, allowing you to
check which step you are currently performing.
Progress indicator
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Auto Screen Adjustment procedure

 Readjust by recalling previous settings
By clicking the [Re-adjust] button, you can restore options to the settings that they had previously.

Note
zz If an option does not have a previous setting, the [Re-adjust] button for that option is disabled.
zz If readjustment fails, Auto Screen Adjustment is canceled. In this case, you can continue making adjustments using the
usual manual procedure from the point at which adjustment was interrupted.
zz To cancel Auto Screen Adjustment in progress, click [Abort]. In this case, you can continue making adjustments manually
from the point at which adjustment was interrupted.
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Auto Screen Adjustment procedure

Projector Layout

1

Specify the projector configuration in the projector layout setting screen.

[Restore]
Layout information display area

[Height / Width / Stack]
Projector layout setting screen
1)
2)

When you click the [Restore] button and layout information from previously configured projectors exists, the layout
information is loaded and applied to the layout information display area.
Enter the height, width, and stack layout for the projectors in the [Height / Width / Stack] fields.
zz Up to 99 projectors can be configured.
- In the case of 1 camera, adjustment can be performed for up to 4 vertically, up to 4 horizontally, and up to 6
stacked.
- 5 or more projectors can be configured either vertically or horizontally by using multiple cameras. In such cases,
the relationship between the number of projectors and the number of cameras is as follows.
Number of projectors

1 to 4

3 to 7

4 to 10

5 to 13

6 to 16

7 to 19

Number of cameras

1

2

3

4

5

6

- 360-degree curved screens require 5 or more projectors in the vertical or horizontal direction and 3 or more
cameras.
Number of projectors

5 to 9

5 to 12

5 to 15

6 to 18

Number of cameras

3

4

5

6

Note
zz You cannot configure a layout that includes more projectors than the total number of connected projectors.
zz If [Geometry + Edge Blending + Color Matching], [Color Matching], or [White Balance] is selected in the adjustment items
selection screen, configure the layout so that one of height (vertical) or width (horizontal) is more than one projector.
3)

Click [Next].
zz To return to the previous screen, click [Back].
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Auto Screen Adjustment procedure

Select the projectors for which to perform correction in the projector selection screen.

Check boxes

Number of
selected
projectors

[Clear All]
[Select All]
Projector selection screen

1)

Select the check boxes of the projectors for which you want to perform correction in the connected projectors list.
zz You can select all the projectors by clicking the [Select All] button, or clear selection of all the projectors by clicking
the [Clear All] button.
zz If you clicked the [Restore] button in step 1 to load previous layout information, the check boxes for the configured
projectors will be selected.

Note
zz If the projector configuration includes projectors of different models, Auto Screen Adjustment cannot be performed. Be
sure to select projectors of the same model.
zz If * is displayed on the left of a projector name, you cannot select that projector for auto screen adjustment.
zz Apply the Auto Screen Adjustment upgrade kit (ET-CUK10) to the projectors or apply the Auto Screen Adjustment
upgrade kit (PC) (ET-CUK10P) to the computer.
“Activation” (page 12)
2)

Click [Next].
zz To return to the previous screen, click [Back].
zz A warning message will appear if projectors of identical resolutions but different models coexist. Click [Next] to
continue the process, or click [Cancel] to reselect projectors.
zz An error message will appear in the following cases.
In such cases, click [OK] and select the projectors again.
- Projectors of different resolutions coexist.
- The number of selected projectors does not match the number of projectors configured in the projector layout
setting screen in step 1.
- When the Auto Screen Adjustment upgrade kit (ET-CUK10/ET-CUK10P) is not applied to either the selected
projectors or computer.

Note
When you click [Next], the geometry correction, edge blending, color/brightness correction, and white balance adjustment
of the projectors will be initialized.
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Confirm projector positioning in the projector positioning screen.

Layout window

Selected projectors
[Undo]
[Reset]
[Identify]

Projector positioning screen
1)

2)

Click the layout window to position the projectors.
zz Configure the projectors in order, starting with the first projector in the list of selected projectors. Each number will
be projected on the screen. Position the projectors in the layout window so that their numbers match the projected
numbers.
zz Click the [Identify] button to verify the actual projector positions on the projection screen. Each projector will project
their numbers on the screen when you click the [Identify] button.
zz You can cancel the positioning of the projector currently being configured by clicking the [Undo] button, or cancel
positioning for all projectors by clicking the [Reset] button.
Click [Next].
zz To save the projector positioning information, click [Next].
zz To return to the previous screen, click [Back].
zz An error message will appear if positioning of all the projectors is not complete. Configure settings again.
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Camera Setting

1

Verify camera connection in the camera connection screen.

[Search Camera]
Check boxes

[Clear All]
[Select All]

Camera connection screen
1)

2)

2

Click the [Search Camera] button.
zz The model names of the detected cameras are listed.
zz If a camera is not displayed in the list, check the following.
- The camera is properly connected
- The camera is turned on
zz Verify that the check boxes of the cameras to be used are selected.
zz You can select all the cameras by clicking the [Select All] button, or clear selection of all the cameras by clicking
the [Clear All] button.
Click [Next].
zz To return to the previous screen, click [Back].
zz When there are 2 or more cameras, goes to "2 Camera layout screen."
zz When there is one camera, goes to "3 Camera setting screen."

Decide the layout (arrangement) of the cameras while checking the captured images in the camera layout screen.
Perform this work when using 2 or more cameras.

[Restore]
Camera layout
[Test Shot]
Camera target ranges

Camera
layout window
(orange frame)

Camera selection
Captured image
display window

1)

2)

Camera setting screen
Set the camera layout.
zz [Horizontal / Vertical]: Camera placement direction (horizontal/vertical)
zz [360 degree screen]: Select this check box when 360-degree screen
Select the cameras and set the target ranges.
zz The target range of the selected camera is indicated by an orange frame in the camera layout window.
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Capture a test shot with the camera.
zz When you click the [Test Shot] button, a test shot is captured with the selected camera and the captured image
appears in the captured image display window.
zz Verify that the target range fits within the captured image.
If it does not fit, check the actual position of the camera, the selection status of the camera, and the target range
setting.
Click [Next].

Note

3

zz The layout settings of the camera may not be able to be changed depending on the conditions.
zz One projector's worth of overlap is required for images captured with cameras that are side by side.
Configure the camera you will use in the camera setting screen.

[Auto Setup]
[Manual Setup]
[White Balance /
Shutter Speed /
ISO / F-number]

Image display window

[Test Shot]

Camera setting screen
1)

2)

Click the [Auto Setup] button.
zz A test pattern appears on the screen, and camera configuration starts automatically.
zz When using 2 or more cameras, configure the settings of all the cameras.
zz The setting values configured in step 1) appear in the [White Balance / Shutter Speed / ISO / F-number] fields.
You can select the [Manual Setup] check box to configure the setting values manually.
Capture a test shot.
zz A test shot is captured when you click the [Test Shot] button, and the captured image appears in the image display
window. Verify that the entire screen fits within the image display window.

Note
zz To obtain the optimal adjustment results, make adjustments so that the target area of the screen fills as much of the
captured image display window as possible.
zz Adjustment may fail if the target area of the screen does not fit properly within the captured image display window.
zz An error message appears if camera configuration fails. In such cases, check the content of the message, click [OK], and
configure settings again.
zz If the screen is too bright or there is a strong light present, overexposure may occur and adjustment may fail.
3)

Click [Next].
zz To return to the previous screen, click [Back].
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Projection Setting
Adjust the option selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page 90).
Perform the operations by referring to their explanations on the following pages.
zz When [Geometry, Edge Blending, Color Matching] or [Geometry, Edge Blending] is selected
“Geometry and Edge Blending Adjustments” (page 97)
zz When “Color Matching” is selected
“Color Matching Adjustments” (page 103)
zz When “White Balance” is selected
“White Balance Adjustments” (page 106)

 Geometry and Edge Blending Adjustments

1

When the following confirmation screen appears, check the content displayed and click [Next].
When you click [Next], the projector settings will change to those displayed on this screen.
zz To return to the previous screen, click [Back].

Setting initialization confirmation screen
(geometry correction and edge blending)
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Configure the screen type and overlap areas in the screen setting screen.
Screen type

Number of cursors

[Reset]
[the last / the second last /
the third last]

Cursor
Screen setting window

[Restore]
[Set temporal value for
Black Level]
[Edge Blending Width]

Screen setting screen
1)

2)

3)

Specify the screen type and number of cursors.
zz Select the screen type that matches the shape of the screen. If [Horizontal Curve], [Vertical Curve] or [H-V Curve]
is selected, specify the number of cursors according to the curvature of the screen.
[4 Corner]: Flat screen
[Horizontal Curve]: Screen that is curved in the horizontal direction
[Vertical Curve]: Screen that is curved in the vertical direction
[H-V Curve]: Screen that is curved in the horizontal or vertical direction
zz When [Cylindrical-H] or [Cylindrical-V] is selected, you can specify 3 to 32 cursors for each side.
When [H-V Curve] is selected, you can specify at 3 or more cursors per side, for a total of up to 300 cursors.
While viewing the actual screen, position the cursors in the screen setting window according to the shape of the
screen.
zz Position each cursor by dragging them or by using the arrow keys on the keyboard. When using the keyboard,
pressing an arrow key while a cursor is selected moves the cursor 8 dots, pressing an arrow key while holding the
Ctrl key moves the cursor 1 dot, and pressing an arrow key while holding the Alt key moves the cursor 64 dots.
zz You can select the next cursor by pressing the Tab key, or the previous cursor by pressing the Tab key while
holding the Shift key.
zz You can also select cursors using the number keys on the keyboard.
zz If cursor layouts were previously configured, you can restore up to the three most recent cursor layout
configurations using the [Restore] button. Select [the last], [the second last], or [the third last] from the pull-down
menu to select the configuration you want to restore, and click the [Restore] button.
zz To return all cursors to their original positions, click [Reset].
zz When the [H-V Curve] screen type is selected, the maximum number of cursors that are actually projected on the
screen at one time is 100. Up to two digits can be be displayed for numbers on the screen, and the 100th, 200th,
and 300th cursors will be displayed as "0." For example, when you want to select the 101st cursor, press the Tab
key while the 100th cursor is selected, or enter "101" using the keyboards number keys.
The cursors that are projected are switched in groups of 100 in different colors. Cursors 1 to 100 are displayed in
yellow, 101 to 200 in orange, and 201 to 300 in magenta.
To configure the horizontal and vertical overlap areas, enter the values in the [Edge Blending Width] fields.
zz You can also use the sliders to specify values.
zz A percentage value that corresponds to the configured pixel count appears in the percent display.
of [Horizontal] and [Vertical]. The
zz To configure the overlap areas automatically, place check marks next to
values resulting from automatic configuration appear in a message after adjustment is complete.
zz To configure the black level values of the overlap areas automatically, select the [Set temporal value for Black
Level] check box. In such cases, the black level settings are overwritten with the provisional values of each
respective model. To leave the current (i.e., pre-adjustment) black level values unchanged, clear the check box.
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If the content being projected has margins and you want to set the margin area, select the check box next to
[Enable] by [Margin Setting] in the check screen setting screen.

Note
zz Setting a screen margin makes it easier to set the position of cursors when making screen settings.
zz Setting of straight margins is possible. Setting of curved margins is not possible.

Screen setting screen

zz The margin setting screen opens.
Select the type for margin with [Margin Type] and then set the margin size as a numeric value.

Margin type

Auto Masking
[Restore]
[Reset]

Margin setting

[Open]

Margin setting screen

zz Select the margin type.
[Horizontal]: Horizontal margins at the top and bottom of the image
[Vertical]:
Vertical margins at the left and right sides of the image
[Custom]: Margins other than the above
zz To use Auto Masking together with margins, configure [Auto Masking].
[OFF]:
Auto Masking is not performed.
[PC-1 / PC-2 / PC-3]: Auto Masking is enabled.

Note
[Auto Masking] will only be applied if the upgrade kit (ET-UK20) has been applied to the selected projector.
“Activation” (page 12)
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zz Specify margins on each side individually. Select either [%] or [pixel] for [Scale] and enter the overall size of the projected
content (including margins) in terms of the percentage or number of pixels. Note that the total margin that can be set on
any given side cannot exceed 60%.
If [pixel] is selected for [Scale], change the numerical value for [Total resolution] according to the overall content size.

zz Click the [Restore] button to restore the margins to the last previously set configuration.
zz Click the [Reset] button to return the configured margin size to the initial value (about 5%).
zz Click the [Open] button to reads reference image files (files with the extension .bmp or .jpeg).

zz When done setting the margins, click [OK].
Display returns to the screen setting screen.
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Click [Start].
To save the projector positioning information, click [Start].
zz A progress bar appears, and Auto Screen Adjustment for geometry correction and edge blending starts.
zz To return to the previous screen, click [Back].

zz To cancel Auto Screen Adjustment, click [Abort].
In such cases, click [OK] when the following screen appears.

5

When Auto Screen Adjustment is successfully completed, the following message appears.
To save the adjustments in the projector, select [PC-1], [PC-2], or [PC-3] as the storage location, or select [None] if you do
not want to save the settings, and then click [OK]. If you click [Cancel] the adjustments are not saved in the projector.

If [Geometry, Edge Blending] was selected at “Starting Auto Screen Adjustment and selecting the adjustment item” (page
90), this completes Auto Screen Adjustment.
If [Geometry, Edge Blending, Color Matching] was selected at “Starting Auto Screen Adjustment and selecting the
adjustment item” (page 90), go on to the procedure for “Color Matching Adjustments” (page 103).
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zz A message appears if Auto Screen Adjustment fails. In such cases, check the content of the message, click [OK], and
configure settings again.
To return to the screen from step 2 ( page 98), click [OK].

zz Capture a test shot, and verify that the entire screen
fits within the image display window. ( page 96)
zz Verify that a large portion of the projected image to be
adjusted fits within the screen.
zz Check that the camera and screen are as close as
possible to directly facing each other.

zz Check the position of the image that is projected on
the screen.

Note
button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment
zz When you click the
appears.
To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

zz The projector layout and cursor layout information configured during Auto Screen Adjustment is stored until the next time
you configure the settings.
zz To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of
Geometry Manager Pro.
“Adjustment and Settings - Geometry Correction” (page 41)
“Adjustment and Settings - Edge Blending” (page 56)
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 Color Matching Adjustments

1

When the following confirmation screen appears, check the content displayed and click [Start].
When you click [Start], the projector settings will change to those displayed on this screen.
zz To return to the previous screen, click [Back].

Setting initialization confirmation screen (color and brightness adjustment)
zz A progress bar appears, and Auto Screen Adjustment for color and brightness adjustment starts.

zz To cancel Auto Screen Adjustment, click [Abort].
In such cases, click [OK] when the following screen appears.
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A message indicating that Auto Screen Adjustment is complete appears.
To exit Auto Screen Adjustment, click [OK].
zz To restore the conditions from before adjustment, click [Before Adjustment]. If you click [After Adjustment] after clicking
[Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

zz The following message appears if Auto Screen Adjustment could not be completed and must be performed again.
To perform Auto Screen Adjustment for color and brightness correction again, click [Continue]. To exit Auto Screen
Adjustment, click [Finish].

①
②

① Colors for which Auto Screen Adjustment was not completed are displayed here.
② Here you can confirm the adjustment results for the selected color on screen.
zz A message appears if Auto Screen Adjustment fails due to overexposure.
If the screen is too bright or there is a strong light present, overexposure may occur. In such cases, click [OK] and
configure settings again.
zz If Auto Screen Adjustment for color and brightness adjustment is performed again and fails to complete, a message will
appear. Click [OK] to exit Auto Screen Adjustment.
In such cases, perform adjustment manually in the main screen of Geometry Manager Pro.
“Adjustment and Settings – Color Matching” (page 68)
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Note
button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment
zz When you click the
appears.
To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

zz The projector layout and cursor layout information configured during Auto Screen Adjustment is stored until the next time
you configure the settings.
zz To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of
Geometry Manager Pro.
“Adjustment and Settings – Geometry Correction” (page 41)
“Adjustment and Settings – Edge Blending” (page 56)
“Adjustment and Settings – Brightness Control” (page 65)
“Adjustment and Settings – Color Matching” (page 68)
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 White Balance Adjustments

1

When the following confirmation screen appears, check the content displayed and click [Next].
When you click [Next], the projector settings will change to those displayed on this screen.
zz To return to the previous screen, click [Back].

Setting initialization confirmation screen
(White Balance Adjustments)

1)

When adjusting color, use the [Auto] option to optimize adjustment for the screen overall, or the [Target Setting] option
when configuring a target (standard) projector.
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If you select the [Target Setting] option, also select the projector that is to be the target.
zz When you click the target projector number, the number and its frame change to red.
zz Click the [Restore] button to restore the last previously set configuration.
zz Click the [Identify] button to verify the actual projector positions on the projection screen. Each projector will project
their numbers on the screen when you click the [Identify] button.

Note
zz White balance is adjusted by configuring the [Picture]-[Color Temperature]-[USER1]-[White Balance High] values.
zz In order to manually pre-configure white balance for the target projector, change the [White Balance High] settings as
described earlier.
zz The results of white balance adjustment are saved to the projector for each input signal. When the input signal is
changed, do the adjustment again.
zz With some projectors that use single-chip DLP, the color matching setting is forcibly set to OFF when white balance is
adjusted. Refer to the operating instructions of the projector.

2

Click [Start].
The projector positioning information is saved.
A progress bar appears, and Auto Screen Adjustment for white balance starts.

zz To cancel Auto Screen Adjustment, click [Abort].
Click [OK] when the following screen appears.
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A message indicating that Auto Screen Adjustment is complete appears.
To exit Auto Screen Adjustment, click [OK].
zz To restore the conditions from before adjustment, click [Before Adjustment]. If you click [After Adjustment] after clicking
[Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

zz The following message appears if Auto Screen Adjustment could not be completed and must be performed again. To
perform Auto Screen Adjustment for white balance again, click [Continue]. To exit Auto Screen Adjustment, click [Finish].

①

① Here you can confirm the adjustment results for the selected color on screen.
zz A message appears if Auto Screen Adjustment fails due to overexposure.
If the screen is too bright or there is a strong light present, overexposure may occur. In such cases, click [OK] and
configure settings again.
zz If Auto Screen Adjustment of white balance is not completed a second time, a message is displayed. Click [OK] to
complete Auto Screen Adjustment.
In this case, perform adjustments manually in the main screen of Geometry Manager Pro.
“Adjustment and Settings - Picture” (page 80)

Note
button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment
zz When you click the
appears.
To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

zz To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of
Geometry Manager Pro.
“Adjustment and Settings - Input Signal Adjustments” (page 75)
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Frequently Asked Questions
Check the following points once more before requesting repair.
Projector is not recognized.
zz Has the projector’s power been turned on?
“Projectors supported” (page 10)
zz IIs the projector supported by the software application?
“Preparation” (page 10)
zz Have the units been connected properly?
“Setting the Projector” (page 11)
zz Has the projector’s network been set up correctly?
zz Has an attempt been made to connect 100 or more projectors?
No connection can be made between my projector and my computer
zz When Windows Firewall has been detected

Windows 7
Is this software registered in [Start] → [Control Panel] → [System and Security] → [Windows Firewall] →[Allowed
programs and features] tab?
To register the software, perform the following.
zz How to set up
1. Click [Start] → [Control Panel].
2. When the <Control Panel> appears, click [System and Security] → [Allow a program through Windows Firewall].
3. When <Allow programs to communicate through Windows Firewall> appears, click [Change settings] → [Allow
another program...].
4. When the <Add a Program> dialog box appears, select [Geometry Manager Pro] and click [Add].
If [Geometry Manager Pro] is not on the list, click [Browse], select [GeometryGUI.exe] and click [Open]. [Geometry
Manager Pro] appears in the [Program] column
5. [Geometry Manager Pro] appears in the [Allowed programs and features] column.
6. Select the network from [Home/Work (Private)], [Public] you want to allow connection to and click to select the check
box.
7. Click [OK] in the <Allow programs to communicate through Windows Firewall].
8. This software will now be added to the Windows firewall's exception list.

Windows 8.1 / Windows 10
Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel] → [System and Security]
→ [Windows Firewall] → [Allow an app or feature through Windows Firewall] to see if this program is on the list.
Add the software to [Allow an app or feature through Windows Firewall].
zz Adding procedure
1. Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel].
2. When the <Control Panel> appears, click [System and Security] → [Allow an app through Windows Firewall].
3. When <Allow apps to communicate through Windows Firewall> appears, click [Change settings] → [Allow another
app...].
4. When the <Add an app> dialog box appears, select [Geometry Manager Pro] and click [Add].
If [Geometry Manager Pro] is not on the list, click [Browse...], select [GeometryGUI.exe] and click [Open]. [Geometry
Manager Pro] appears in the [App] column
5. [Geometry Manager Pro] appears in the [Allowed apps and features] column.
6. Select the [Private] or [Public] network you want to allow connection to and click to select the check box.
7. Click [OK] in the <Allow apps to communicate through Windows Firewall>.
8. This software will now be added to the Windows firewall's exception list.

<When another firewall has been detected>
Are any firewall-containing applications installed?
If any applications which contain firewalls are installed, the installation may not complete.
(The firewall function may activate without launch of the application if the application has already been installed.)
If this occurs, firewall settings must be changed in order to allow connection to the network.
See the User’s Manuals for all applications containing firewalls to perform these settings.
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Frequently Asked Questions
Messages that appear when an attempt to uninstall or update the software is made
<Is the "Warning 1910. Could not remove ..." message displayed?>
If an NVIDIA driver is installed on the computer, the following message may appear.

Click [OK] to continue an uninstall or update procedure.
Although uninstalling the software will also remove the desktop shortcut icons, they will be regenerated when you start
up the computer next time. Manually delete the shortcut icons.
Files cannot be saved.
zz Has an attempt been made to save a file that includes values that exceed the range which can be set in the projector?
zz Is there enough free memory on the hard disk?
zz Do you have the authority to access the folder in which the file is to be saved?
Image correction cannot be performed.
zz Have settings been sent to the projector that exceed the range which can be set in the projector?
zz Has the projector’s power been turned on?
Some items cannot be set if the projector’s power is not on.
zz Are the projector’s input connectors set correctly, and have the correct signals been input?
Some items cannot be set depending on the input connector settings, the types of signals input and whether or not
signals are present.
The bitmap used for masking purposes cannot be loaded.
zz Has an attempt been made to load bitmap data which is not in the 1-bit monochrome format?
zz Does the bitmap have the appropriate size?
Bitmaps smaller than 8 x 8 pixels and bitmaps larger than 1920 x 1200 pixels (when the resolution of the projector is
1920 x 1200 dots or 1400 x 1050 dots) or 3840 x 2400 pixels (when the resolution is other than the aforementioned)
cannot be used for masking.
Cannot connect to the camera (Auto Screen Adjustment).
zz Is the camera turned on?
zz Is the camera connected to the computer properly?
zz Is there a large number of data files stored on the SD card inserted in the camera?
If camera connection fails, try removing the SD card and performing the camera connection settings again.
Auto Screen Adjustment does not start.
zz You may not be able to execute Auto Screen Adjustment depending on the projector's settings. For details on
operations restricted by the projector's settings, check the information found on the software download page after
logging in to PASS on the Panasonic website (http://panasonic.net/avc/projector/pass).
The image does not fit exactly on flat screens (Auto Screen Adjustment).
zz The projected image may not match the edges of the screen exactly if the screen is sagging.
If the top and bottom edges are off:
In the screen setting screen, set the screen type to [Horizontal Curve], and specify at least 3 cursors according to the
shape of the screen.
If the left and right edges are off:
In the screen setting screen, set the screen type to [Vertical Curve], and specify at least 3 cursors according to the
shape of the screen.
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Frequently Asked Questions
Geometry correction results in an images that appears curved (Auto Screen Adjustment).
zz This occurs on soft curved screens and on screens with heavy sag.
Correction is performed so that the image appears straight from the point of view of the camera.
Position to the camera so that it is as close as possible to directly facing the screen.
An exposure adjustment error occurs on the camera (Auto Screen Adjustment).
zz If the projector is too bright or the screen's gain is high, for example, an exposure adjustment error may occur during
camera settings configuration.
In such cases, attach an ND filter to the camera lens, or lower the brightness of the projector before performing
adjustment again.
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Trademarks
zz Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other
countries.
zz Other company names, product names or other names noted in this manual are trademarks or registered trademarks of the
respective companies. Note that ® and TM marks are not indicated in the text of this manual.

Note
zz Unauthorized use or reproduction of part or all of this software and manuals is strictly prohibited.
zz Panasonic cannot be held liable for any effects resulting from the use of this software and manuals.
zz Panasonic reserves the right to revise this software specifications and manual contents without notice.
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